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Chapter 1:  
Introduction 

 
SUPPLIERtrak is the most comprehensive supplier quality assurance software available. It helps gather 
information to create performance reports on any supplier over any time frame, so users can identify the best 
and worst performers, according to criteria they set themselves.  
 
SUPPLIERtrak records incoming inspection results and generates accept and reject tags for incoming parts 
and materials; it also creates rejection notices, inspection sheets and supplier rating reports. Users can set up 
skip-lot, rejection, and calendar alarms for inspections. On-line inspection procedures ensure that items are 
checked accurately and consistently.  
 
This new version offers an improved, reorganized interface, tabbed so data is more accessible. Two user-
definable fields in Supplier Entry let users record critical information unique to their industry. New reports and 
charts with flexible formatting to meet your needs better, and data import and export features to help you work 
with your data outside of SUPPLIERtrak. New database management features help keep your data safe, secure, 
and up-to-date. SUPPLIERtrak is an easy-to-use, easy-to-learn tool that helps analyze supplier data in ways 
you may not have considered before.  
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Chapter 2: Installing 
and Running 
SUPPLIERtrak 

You can install SUPPLIERtrak onto your hard drive and optionally place the database on the network. This 
chapter gives you the installation instructions. 

Program Requirements 
SUPPLIERtrak requires the following: 

 Microsoft Windows 98 SE/2000/XP 
 Pentium 800 MHz CPU required; 1 GHz or faster recommended 
 Hard disk with 250 MB of free space for program files and 50-75 MB of free space for typical 

database 
 256 MB RAM required; 512 MB recommended 
 SVGA or compatible display monitor at 800 X 600 resolution or higher 
 Mouse or compatible pointing device 
 Default Windows Printer (if you want to print reports) 

 
SUPPLIERtrak Network Requirements: 

 Optional: This section will only apply if the data file will be shared over the network or will be 
part of a regular network backup. 

 Network folder with full rights for each SUPPLIERtrak user 
 100 MB LAN 

Upgrading 
If you are upgrading from an older version of SUPPLIERtrak, perform the program installation as described in 
the next section, then refer to the “Data Transfer Utility” in the Appendix for details on transferring your current 
database records to this version of SUPPLIERtrak. 

Program Installation 
Installing SUPPLIERtrak 

 
Note: If Auto Run is enabled on your computer, the Setup program will run automatically and you can skip to 
number 5 below. 

1. Close out of all other programs, and click the Windows Start button.  
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2. Select the Run... command. 

 
3. Place the SUPPLIERtrak CD into your CD-ROM drive. Next, click Browse... and Browse for the CD-

ROM drive letter. Select SETUP.EXE from the file listing. It will appear in the Open field of the Run 
box. You can also type the drive letter and file name here. 

The example here shows the D drive as the CD-ROM drive, with Setup file selected. 

 
4. Click the OK button. 
5. Follow the setup instructions on the screen. 
6. By default, the program will be installed to the C:\Program Files\SPW46 directory. If you 

experience problems during installation, please see the Trouble Shooting section in the Appendix. 
 

Network Installations 
If you want your database file to be stored on a network drive, then do the following before running 
SUPPLIERtrak for the first time (repeat these steps for each workstation installation): 

1. Install the program to the workstation’s local hard drive, as described above. 
2. Create a data directory on the server (the directory name should still be SPW46. Make sure the 

workstation user has full rights in the directory). 
3. Move the SPDATA46.MDB file from the workstation’s local SUPPLIERtrak program directory to 

the network server‘s data directory that you created in Step 2. 
4. Run SUPPLIERtrak for the first time, go to the File menu, and then select Open Database. 

Browse to the folder SPW46, then the SPDATA46.MDB file on the server.  
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Running SUPPLIERtrak 
To run SUPPLIERtrak, execute the SUPPLIERtrak icon in the SUPPLIERtrak Program Group or double-click the 
SUPPLIERtrak shortcut icon on your Windows Desktop. 

 

Starting SUPPLIERtrak from the Start Menu  
1. Click the Start button. 

 
 

2. Select Programs. 

 

3. Select the SUPPLIERtrak 4.6 program group. 
4. Then choose SUPPLIERtrak 4.6. 

SUPPLIERtrak Logon 
When you run SUPPLIERtrak, a logon window may appear, as shown here (only if you have set up security): 

 
Enter your PIN number and click the OK button. See the section on User Settings for more information about 
setting up this security feature.  

SUPPLIERtrak Serial Number 
If you have not entered your program serial number into the About box, the following message screen will 
appear to remind you to enter it. 
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Click the OK button, and the About window will appear. Enter the serial number for your copy of SUPPLIERtrak 
(the serial number is located in your manual or on the packing list that came with your package). If you cannot 
locate your serial number, please contact CyberMetrics Technical Support at (480) 922-7300. 

 
The About window, shown above, gives you information about the current number of users that have been set up, 
in addition to information about your number of records. 

SUPPLIERtrak Main Menu 
The SUPPLIERtrak main menu is shown below. Note that the name of the currently logged-in user is displayed 
towards the lower left corner. The full path to the currently open data file is displayed in the lower right corner. 
SUPPLIERtrak’s Outlook style interface is easy to learn and use, with clean, clear graphics and an intuitive 
approach that makes extensive training sessions and manuals unnecessary. 
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This table shows how the different SUPPLIERtrak menus are organized.  
Menu Button Options 
Main Records Supplier Entry 

Supplier Part Entry 
Received Material Entry 
Procedure Entry 
Staff Entry 

Ratings and Surveys Ratings Entry 
Survey Entry 

Reports Supplier Reports 
Part Reports 
Received Reports 
Rejections Reports 
Survey and Rating Reports 
Miscellaneous Reports 
Inspection Reports 
Staff Reports 

Graphs Part Comparison Chart 
Supplier Performance Chart 
Supplier Comparative Chart 
Worst Supplier Chart 

Setup Settings 
Rating / Survey Wizard 
Setup Users 
Report Control ID Entry 
Ratings Definition 
Survey Definition 
Rejection Coding Setup 
Corrective Action Statement Entry 

Data Tools Backup/Restore 
Import/Export 
Compact/Repair Data 
Modify License 

Utilities Archive/Un-Archive Receiving Data 
Archive/Un-Archive Suppliers 
Edit All Tables 
Reset Early / Late 
Update Supplier Next Rating Due 

 
If you installed to a directory other than C:\Program Files\SPW46, or the program cannot find your database file, 
then the Where Is The Data File? window will appear. In this case, you will need to tell SUPPLIERtrak where to 
find the database file named “SPDATA46.MDB”. The Where Is The Data File? window is shown below:  

 

 
Note: Users who have their database file located on the network server must be logged into the network 
operating system before they can open the database file. 
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If this window appears, click the local or network directory under the Look In box, and then navigate through the 
folders to the database location. Choose the database file name, “SPDATA46.MDB”, so it will appear in the File 
Name dialog box, and click Open. The database should then successfully connect. 

SUPPLIERtrak Settings 
To enter your company name and insert a logo, go to the Tools and Utilities menu and select Settings. You can 
also Enable an Audit Trail and change the Corrective Action Statement in Settings. Please see the Tools and 
Utilities chapter for information on Settings. 

 

Database Security 
When you select Set Up Users from the Tools and Utilities menu, the User Entry screen will appear.  
The Set Up Users feature allows you to add new SUPPLIERtrak users and set each one’s rights for each of the 
program areas. User Information, Record Access and Security are found in the Tools and Utilities section of the 
manual. 

 

Date Formats 
SUPPLIERtrak supports all of the available numeric date formats within Windows. For example, you can 
represent the date of November 1, 2002 as: 11/1/02, 11/01/02, 11/1/2002, 02/11/1, 02/1/11, or 2002/11/1, depending on 
your preference. As a precaution, you may wish to verify the date settings in Windows Control Panel. The date 
formats that are entered into SUPPLIERtrak must match the Windows Control Panel date setting; otherwise, 
errors will occur while you’re running the program. 
 
Begin by clicking the Start button, go to Settings, and then select the Control Panel. Double-click on Regional 
Settings icon, and then click the Date tab. 

 
Place your cursor in the Short Date Style field, click the arrow, and select a format with a four-digit year, such 
as M/d/yyyy or MM/dd/yyyy. 
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Chapter 3: Supplier 
Master Records 

Use supplier master records to store information about your suppliers. Each supplier needs a unique code 
number (the code can include both numbers and letters). Each supplier requires a code number because: 

1. Some suppliers may have the same name (or very similar names). A code number will help prevent 
ambiguity and mistakes. 

2. Larger suppliers can have the same name, but may ship from multiple plants or divisions. You will 
probably want to track each supplier’s shipping location separately. 

 
Due to the relational hierarchy of the SUPPLIERtrak database, supplier master records must be created before 
you can enter receiving records, supplier part records, rating records, and survey records. 
 
To enter supplier master records, select Supplier Master Entry from the Enter/View Records menu. Next, enter 
any search fields (just click the Find button if you are entering new records).  
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The record entry form will appear, showing your first record. Click the New button on the upper right corner of 
the screen to add a new record. If you are looking for a certain record, use the navigation buttons to scroll 
through the records, or use either the Find or Edit Filter/Sort options in the Record menu. 

 

Supplier Master Record Fields 
The following fields are used in the supplier master record: 

  
Field/Button Name Description 
Supplier Code  A unique alpha/numeric identification entry that must be placed in a record in order to 

store it. Of course, you will have to develop a numbering system. Important: To ensure 
proper sorting of records, you should make sure that all supplier codes are the same 
length. For example, do not use codes like A-1, A-2, A-100; instead, use codes that are the 
same length, such as A-001, A-002, A-100. Try to keep your coding system simple. 

Supplier Name  The name of the supplier company. 
Contact The name of the contact person at the supplier company. 
Phone The telephone number of the supplier. 
Address  The street address of the supplier company. 
City The city of the supplier company. 
State The state (or province) of the supplier company. 
Zip The zip code (or postal code) of the supplier company. 
Country The country of the supplier company (optional). 
Last Survey The date of the last Survey. 

Can be entered manually, but also is updated by the software. 
Last Rating The date of the last Rating 

Can be entered manually, but also is updated by the software. 
Last Received The date of the last Receiving Record. 

Can be entered manually, but also is updated by the software. 
Last Reject The date of the last Reject Record. 

Can be entered manually, but also is updated by the software. 
Enabled Is this Supplier current, But not yet archived? 
Supplier User 1 and 2 User defined fields that relate to this particular Supplier. 
Rating Frequency At what interval does a Rating have to be completed for this Supplier? 
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Field/Button Name Description 
Rating Frequency UOM Enter the frequency of ratings, using the unlabeled list box field on the right for the 

frequency units (for example, “45 DAYS”). When the software calculates the next 
rating due date, it uses this value.  
Your choices for the Units field are explained below:  
Days—schedule is based on elapsed calendar days  
Weeks—each week equals seven days; schedule is based on elapsed calendar weeks  
Months—schedule is based on elapsed calendar months  
EOM—rounds the next due date to the end of the month in which it occurs. For 
example, “6 EOM” means every 6 months, but the program extends the due date to the 
end of the sixth month (or the last working day of the month if you’re using skip days – 
see the System Administrator’s Guide for more information)  

    Years—each year equals 365 days; schedule is based  on                       elapsed calendar 
years 

Next Rating Due The next Rating due date, entered manually or calculated by the software. 
Parts Table This is an embedded table of supplier part records.  
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Supplier Rating History 
 This tab will display a sub form of the details of this supplier’s historical rating. 
 

 
 

Supplier Procedures 
If needed, you can set up receiving inspection procedures for suppliers. These procedures can be shared with 
many suppliers or can be specific to one supplier. For example, you may have special tests that must be done on 
all incoming materials from a certain supplier (supplier-specific procedures). On the other hand, you may have 
other tests that must be done on incoming materials from a certain group of suppliers (shared procedures). 
 
If the inspection procedure is part specific, then you’ll need to enter the part procedure into the Supplier Parts 
Entry form. 

Note: If you’re entering a new supplier record, then make sure that you first save the supplier record (i.e., 
click on the record selector bar on the left side of the form or do a PAGE DOWN/PAGE UP sequence on the 
keyboard) before attempting to enter a procedure record.  
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To create relationships between suppliers and procedures, click on the Procedures tab, and the Procedure Entry 
sub form will appear. Select the procedure name and then the text of the procedure (there is no limit to the 
number of lines of procedure text). If you want to use a procedure that you entered previously on another 
supplier, then use the same procedure name.  

 
On the Procedure Image tab of this window is the OLE Box field. “OLE” stands for Object Linking and Embedding. 
This means that you can view any Linked valid Windows object (such as a graph, picture, or digitized movies) that 
has been placed into this field when the procedure was created in Procedure Entry.  
 
Also in this sub form is the Attachments tab. This allows you to view any file attachment attached to this 
procedure when it was created in Procedure Entry. 

 

If you want to enter another procedure for the same supplier, then click on the right navigation button of the 
procedure window. 
 
Click the Exit button (or double-click the procedure window’s Control Menu icon) when you are through entering 
procedures, and you will be returned back to the underlying Supplier Entry form. 

Supplier Alarms 
There are two kinds of supplier alarms that can be set up. The first kind is a skip-lot alarm that will be triggered 
after you receive a user-defined number of shipments (lots).  The second kind of alarm is calendar-based and will 
be triggered when you enter a receiving record for the supplier on or beyond a user-specified date. 

 
Alarms are triggered in the Received Material Entry form. Whenever an alarm is triggered, the user has the 
option of resetting the alarm (click the Clear button) or postponing the alarm (click the Snooze button). If the 
alarm is postponed, it will continue to be triggered with each shipment from the supplier until you reset it.  
Choosing the Reset button will reset the count to zero. 

Note: As with procedures, if you are entering a new supplier record, make sure that you first save the 
supplier record (i.e., click on the record selector bar on the left side of the form or do a PAGE DOWN/PAGE UP 
sequence on the keyboard) before attempting to enter an alarm record.  
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To enter supplier alarms, click on the Alarms tab, and the Supplier Master Alarm Entry sub form will appear. 

 

Skip Lot/Rejection Alarm  
The supplier counter alarm fields are explained below:  

Field/Button Name Description 
Skip Lot Alarm  This is the point at which the counter alarm is triggered. When the 

value entered here is reached, the alarm is displayed. If this is set to 
an extremely high value (i.e., a value that will never be reached), then 
the alarm will not be triggered. When you click the Clear button, this 
field is set to 2,000,000,000 (two billion) - a value that for all practical 
purposes, will never be reached. When this field is set to 
2,000,000,000, or blank the counter alarm is turned off.  

Current Shipment 
Count  

This is the current count of shipments (lots) received since the alarm 
was last reset. This is set to 0 (zero) when you click the Clear button. 
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Supplier Calendar Date Alarm 
The supplier calendar alarm fields are explained below:  
Field/Button Name Description 
Calendar Alarm Date  
 

The calendar alarm will be triggered on this date. If a receiving record for the 
supplier is entered on or beyond this date, the alarm will be displayed. If this field is 
blank or set to a date far into the future (such as the year 2100), then the alarm will 
not be activated.  

Alarm Date Message This is the message that will be displayed when the calendar alarm is triggered. This 
is set to blank when you click the Clear button. Remember that you must press 
CTRL-ENTER to insert new lines into memo fields.  

 
The Supplier Calendar Date Alarm is triggered when the user receives material on or after the date entered from 
the Receiving screen. Under QS-9000 rules, a supplier does not normally need to have shipments inspected. 
However, if a rejection is made, they are to inspect the Supplier’s next five shipments.  

 

 

 
When you have completed the entry of the Alarms for the supplier, click on the Close button to save your alarm 
settings and return to the underlying Supplier Entry form. 
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Chapter 4: 
Supplier Part Entry 
Supplier Part Records 

Use Supplier Part records to store information about your supplier parts (and materials). You must set up your 
Supplier Part records before you can enter them in the receiving records. In the receiving records, you can 
select both the supplier and supplier parts from list boxes (to save time from manually typing them and to avoid 
data entry errors).  
 
The program does allow for part numbers to be duplicated between suppliers; however, they cannot be 
duplicated for the same supplier. In other words, two suppliers can share the same part number, but you 
cannot repeat the same part number for the same supplier. 
 
You can enter part records either from the Supplier Master Entry form (described earlier), or from the Supplier 
Part Entry form (discussed next). 
 
To enter part records, select Supplier Part Entry from the Enter/View Records menu. In the filter window, enter 
any search fields (just click the Find button if you are entering new records).  
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The record entry form will appear, showing the first record. Click the New button on the navigation panel to add 
a new record. If you are looking for a certain record, use the navigation buttons to scroll through the records, or 
use either the Find or Edit Filter/Sort options in Record menu. 

 

 

Supplier Part Record Fields 
The following fields are used in the supplier part record: 

  
Field/Button Name Description 
Supplier Code  The supplier code from the supplier master record. Click on the list box arrow to 

choose from available suppliers. 
Supplier Name  The program looks up and displays the supplier name after you enter the supplier code 

for the part. 
Supplier Part No. The number that the supplier uses to identify the part or material. As described earlier, 

this number can be duplicated for different suppliers. 
Company Part No. The number that your company uses internally to identify the part or material. This 

number also can be duplicated for different suppliers. 
Description The description that your company uses internally to identify the part or material. This 

description also can be duplicated for different suppliers. 
Unit of Meas. The unit of measure in which you track the part (such as each, pounds, feet, or gallons). 

This field creates a self-building, drop-down list box that will display all previously 
entered information to save typing time and avoid data entry errors. 

Sampling Plan The sampling plan code associated with this supplier part. 
Unit Cost The unit cost of the part (rounds to nearest penny). 

Currency The currency symbol associated with this supplier part. 
Drawing Date The Drawing revision date associated with this supplier part. 

The historical drawing revision information is stored in the Receiving table for each 
receiving record throughout a part’s receiving history. 

Drawing Number The current Drawing revision number associated with this supplier part. 
Change Date The Change revision date associated with this supplier part. 

The historical change revision information is also stored in the Receiving table for each 
receiving record throughout a part’s receiving history. 

Change Level The current Change revision number associated with this supplier part. 
Last Received Date Can be entered manually, but is also updated by the software. 
User Defined 1 and 2 User defined fields that relate to this supplier part. 



 SUPPLIERtrak™  Quick Start Guide 31 
 

 

 

Inspection Characteristics Table 
Located at the bottom of the form is an embedded table of inspection characteristics. You can set up a list of as 
many items as needed to check for when receiving the part. Each characteristic has the following fields: 

  
Field/Button Name Description 
Characteristic The name of the characteristic being checked, such as width or viscosity. This list is 

maintained alphabetically (not in the order in which you originally entered them). If you 
want to control the order, then you should prefix each entry with a number and period, 
such as 1. Width, 2. Height, 3. Length. 

Value V is usually used for Variable numeric data; A is usually reserved for Attribute (visual 
inspection etc.) data. 

Minimum The minimum acceptable value of the characteristic (lower specification limit).  
Nominal  The nominal value for the characteristic (target or best value).  
Maximum The maximum acceptable value of the characteristic (upper specification limit). 

 

Supplier Part Procedures 
If needed, you can set up receiving inspection procedures for parts and materials in Procedure Entry. These 
procedures can be shared with many other parts or can be specific to one part. For example, you may have 
special tests that must be done only on a certain part from a certain supplier (part-specific procedures). On the 
other hand, you may have checks that must be done on incoming materials from a certain type of part or 
material coming from a variety of suppliers (shared procedures). 

Note: If you are entering a new part record, then make sure that you first save the part record (i.e., click on 
the record selector bar on the left side of the form or do a PAGE DOWN/PAGE UP sequence on the keyboard) 
before attempting to enter a part procedure record. Failure to do so will result in the error message “Can’t 
Have Null Value in Index” when you try to enter the procedure. 

To select part procedures, click on the Procedures tab, and a procedure entry sub form will appear. Select the 
procedure name and then the text of the procedure will appear. If you want to use a procedure that you entered 
previously on another part, then use the same procedure name.  
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Also in this sub form is the Procedures OLE tab. “OLE” stands for Object Linking and Embedding. This means 
that you can view any linked valid Windows object (such as a graph, picture, or digitized movie) that has been 
entered into this field when the procedure was created in procedure Entry.  
 
Also in this sub form is the Attachments tab. This allows you to view any file attachment attached to this 
procedure when it was created in Procedure Entry. 

 

Click the Exit button when you are through entering procedures, and you will be returned back to the underlying 
Supplier Part record entry form. 

Part Alarms 
As with supplier alarms, there are two kinds of part alarms that can be set up. The first kind is a skip-lot alarm 
that will be triggered after you receive a user-defined number of shipments (lots) of a part. The second kind of 
alarm is calendar-based and will be triggered when you enter a receiving record for the part that is on or 
beyond a user-specified date. 
 
To enter part alarms, click on the Alarms tab of Supplier Parts, and the Alarm Entry sub form will appear.  

 
Alarms are triggered in the Receiving Entry form. Whenever an alarm is triggered, you can reset the alarm 
(click the Clear button) or postpone the alarm (click the Snooze button). If the alarm is postponed, it will 
continue to be triggered with each shipment from the supplier until you reset it. The example provided above 
shows a supplier part for which the default of no realistic alarms will ever be reached (20000000 receiving 
records?, or a date beyond the year 2100?), thereby sequestering the alarm capabilities of the software for this 
supplier part. 

Note: As with procedures, if you are entering a new part record, then make sure that you first save the part 
record (i.e., click on the record selector bar on the left side of the form or do a PAGE DOWN/PAGE UP 
sequence on the keyboard) before attempting to enter an alarm record. Failure to do so will result in the 
error message “Can’t Have Null Value in Index” when you’re trying to enter the alarm. 

Part Counter Alarm 
The part counter alarm fields are explained below:  
Field/Button Name Description 
Skip Lot Alarm  This is the point at which the counter alarm is triggered. When the value entered 

here is reached, the alarm is displayed. If this is set to an extremely high value (i.e., 
a value that will never be reached), then the alarm will not be triggered. When you 
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Field/Button Name Description 
click the Clear button, this field is set to 2,000,000,000 (two billion) - a value that for 
all practical purposes, will never be reached. When this field is set to 2,000,000,000, 
or blank the counter alarm is turned off.  

Current Shipment Count This is the current count of shipments (lots) received since the alarm was last reset. 
This is set to 0 (zero) when you click the Clear button. 

 

Example of Part Rejection Alarm when triggered:  

 

 

Part Calendar Alarm 
The part calendar alarm fields are explained below:  
Field/Button Name Description 
Calendar Alarm Date The calendar alarm will be triggered at this date. If a receiving record for the part is 

entered on or beyond this date, the alarm will be displayed. If this field is blank or set to 
a date far into the future (such as the year 2100), then the alarm will not be activated.  

Alarm Date Message This is the message that will be displayed when the calendar alarm is triggered. This is 
set to blank when you click the Clear button is clicked. Remember that you must press 
CTRL-ENTER to insert new lines into memo fields. 

Example of Part Calendar Alarm when triggered: 

 

When you have completed the entry of the Alarms for the part, click on the Close button to save your alarm 
settings and return to the underlying Supplier Parts Entry form. 

 

Part Entry Attachments 
The Attachments tab of Supplier Part Entry is similar to procedure and supplier attachments. The files used for 
attachments can be of any file type that is supported on user’s workstations and registered in the Windows 
Registry. For example, if a CAD file is attached, and a user of SUPPLIERtrak does not have CAD software 
installed on their workstation, the file will not be able to be viewed or printed from that workstation. 
 
Files used in Part or any other attachment area in the software should reside on a common network drive, with 
common drive mappings between the range of SUPPLIERtrak users. Case in point is the example above. 
If the attachment is C:\Drawings\Part001.drg on one user’s pc and it is attached in SUPPLIERtrak, then another 
user of SUPPLIERtrak will not be able to see it due to it is not at C:\Drawings on their workstation. 
If the File is on G:\Products\Specifications\Part001.drg, and is attached in SUPPLIERtrak, then if at another 
user’s workstation the same folder is mapped differently, say M:\Specifications\Part001.drg, they will not be 
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able to view the attachment as it is stored in the database due to the fact that this second user has his Drive M 
mapped to the first (attaching) user’s G:\Products directory on the network file server. 
 

 
 

Part Entry Receiving History 
The Receiving History tab shows a form with the complete receiving history with rejection records for this 
supplier part. The example screenshot below shows a part that has been received once that just happens to 
have a single rejection record associated with that receiving record. 
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Clone Part Feature 
Part cloning allows you to create additional identical parts that have a different part number or to create exactly 
the same part for a different supplier. 

 
After you have entered all of the information for the part to be cloned, click the Clone Part button on the lower 
right corner of the Supplier Parts entry screen. 

 

 
  

Field/Button Name Description 

New Supplier Code Enter the supplier code for the new part, or select it from the list. 

New Part No. Enter the part number for the new part.   
 

Next, click the Clone button. All of the information that was entered for the original part will be copied to the 
part record for the cloned part, including Part Characteristics, Part Alarms, and Procedures. If you have several 
similar or identical parts, you can use Clone Part as many times as necessary. 
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Chapter 5: Received 
Material Entry 
Received Material Records 

Use the Received Material records (receiving records) to track and log all incoming parts and materials. The 
program automatically assigns a receiving log number to each record. This number is incremented by a value of 
one each time a new record is added. To save time, the program automatically enters the current date into both 
the Received Date and Due Date fields as well as the name of the current user into the Inspected By field.  
 
To enter receiving records, select Received Material Entry from the Enter/View Records menu. Next, enter any 
search fields (just click the Find button to see all un-archived receiving records or insert a 0 (zero) in the 
Receiving Log No field to enter a new record).  

 

 
The record entry form will appear, showing either a new record or the first record. Click the New button on the 
navigation panel to add a new record after reviewing existing records. If you are looking for a certain record, use 
the navigation buttons to scroll through the records or use either the Find or Edit Filter/Sort options in the 
Record menu. 
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Received Material Record Fields 
The following fields are used in the received material record: 

  
Field/Button Name Description 
Receiving Log No. The receiving log number is used to uniquely identify each receiving record. The value is 

incremented by one each time a new record is added. This field will display “(Counter)” until 
a supplier code and part number have been entered. This log number is used to relate the 
receiving record to both inspection measurement records and rejection records (if entered). 
This field cannot be edited. 

Supplier Code  Enter the supplier code or use the list box to select a supplier code. Entry required. 
Supplier Part No Click on the list box button to choose from the available list of part records for the supplier 

code that was chosen. Note: if you enter a part number that does not yet exist for this 
supplier, you can add it from this screen. 

Fields In Gray Company Part No, Description, Drawing No, Change Level, Sampling Plan and Unit of 
Measure are all related to the Supplier Part information at the time of creation of this 
particular receiving record and are un-editable. 
Fields in Gray that are un-editable by the user because they are calculated solely by the 
software are the Lead Time, Days Early or Late, Quantity Rejected and Quantity Accepted 
fields. Quantity Rejected is updated by creating rejection records on the Rejects tab of the 
Received Material entry form, and is the sum of all Quantity Rejected from the associated 
rejection records. Quantity Accepted is calculated as Quantity Received minus total Quantity 
Rejected for each particular receiving record. 

Receive Date The receive date of this receiving record, When a new record is created, the default date is 
always today. 

Quantity Received The quantity received of this supplier part that relates to this receiving record. 
Quantity Inspected The quantity inspected of this supplier part that relates to this receiving record. Usually, this 

number is dictated by the sampling plan that is chosen for this supplier part. 
Received By The person receiving this shipment(s). 
Inspected By This is a general field for the receiving record. The Inspection records for each part selected 

of the Quantity Inspected can each have their own Inspected by code, indicating possibly 
different inspectors, and different times of inspection 

Rejection Code This is also a general field for the receiving record. The Rejection records for each part 
selected of the Quantity Rejected can each have their own Rejection code, indicating possibly 
different rejection reasons, and different times of rejection 

User Defined 1 and 2 User defined fields that relate to this receiving record. 
Shipper Number Used to document the Shipper if fulfillment is used and FOB, for example. 
Lot No Tracks the assigned Lot number of this shipment of this supplier part. This receiving record 

may be only a portion of the total number ordered, or may contain items backordered from 
an earlier order. 

Carrier Used to document the Carrier of the shipment that relates to this receiving record. 
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Field/Button Name Description 
PO Number Purchase Order number of shipment / lot received. 
Order date Manually entered. The order date of this material. The difference between the Order Date 

and the Receive Date is used to calculate the Lead Time. There are no skip Days / Dates 
associated in the software for the calculation of Lead Time because it depends on shippers 
and suppliers and elements outside of the scope of the software. 

Due Date Manually entered. The expected due date of the arrival of this material. The difference 
between the due date and the receive date (minus the grace periods selected in Setup – 
Settings) is used to calculate early or Late. 

Comments Enter any comments. Remember to press CTRL-ENTER to insert new lines of text into the 
Comments field. 

Viewing Receiving History 
To view the complete history of receiving records for the part or material, click on the View History button. A 
pop-up window will appear, as shown here (click the Close button when you’re finished viewing the history):  

 

Viewing Supplier Rating History 
To view the complete history of rating records for the supplier of this part or material, click on the small ellipsis 
button to the right of the Supplier Code selected for this receiving record. A pop-up window will appear, as 
shown here (click the Close button when you’re finished viewing the history): 
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Inspection Forms 
To print an inspection form, click on the Insp. Form button. This form is useful for data collection purposes. It 
will include important information describing the part as well as a list of characteristics to inspect. An area for 
recording your results is provided.   
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Viewing Procedures 
To view either supplier or part procedures, click on the corresponding tab—either the Supplier Procedures tab 
or the Part Procedures tab. There are two buttons that allow you to print or view the procedure.  
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The display report has the same appearance as the procedure report.  

 

Entering Inspection Results 
To enter inspection results, click on the Inspect Material  tab, and the parts inspection sub form will appear. 
This form consists of a top header portion and an imbedded table of inspection characteristics at the bottom for 
entering measurements. 

 
Each form represents the inspections on a single part. The entry fields are as follows: 

Inspection Results Header  
Field/Button Name Description 
Lot No This will default to the information that’s entered on the underlying receiving record form. It 

is used in the event that each sample part comes from different lots. This field can also be 
used to track other information as well; however, you must not leave it blank. 

Part ID This field will automatically number starting at 1 and continue up to the number of parts 
inspected. It can be manually overridden with user data, usually dictated by the sampling 
plan associated to this supplier part. 

Inspected By Select who is performing the inspection on this part this inspection date. 
Inspected By Name Grayed out – Filled in by the software program after an employee code (from the Staff 

Table) is selected in the Inspected By field. 
Inspection Date Enter the date of this part’s inspection. 
Accepted This field is used to track whether or not the part has been accepted. 
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Inspection Measurement Table 
To enter the list of pre-defined inspection characteristics, click on the button called Insert Characteristics List. 
Of course this works only if you set up a list of characteristics in the supplier part records. Otherwise, you will 
have to manually enter the characteristic names, minimums, nominals and maximums. 
 
The table fields are as follows:  

Field/Button Name Description 
Characteristic The name of the characteristic being measured, such as width or Viscosity. This list is 

maintained alphabetically (not in the order in which you enter each item). If you want to 
control the order, then you should prefix each entry with a number and period such as 1. 
Width, 2. Height, 3. Length. 

Type The type of characteristic where V=Variable and A=Attribute (pass/fail).  
Minimum  The minimum acceptable value of the characteristic (lower specification limit).  
Nominal The nominal value for the characteristic (target or best value).  
Maximum The maximum acceptable value of the characteristic (upper specification limit). 
Value The actual measured value of the characteristic or text, such as PASS or FAIL. 

 
Click on the navigation panel’s New button to add another inspection record for another part. Click on the 
navigation panel’s Close button to save your entries and return back to the underlying receiving record. 

Entering Rejection Records 
To enter rejection records, click the Reject Material tab, and the rejection entry sub form will appear.  

 

Note: You can enter multiple rejection records for a single receiving record, the reject ion codes and 
reasons for rejections can vary for any given receiving log entry. Each rejection record by default will have 
the default Corrective Action statement from the Setup > Settings > General tab, but each reject record can 
have this Statement changed to any other Corrective Action statement entered from Corrective Action 
statement entry also in the setup area of the software. 
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Rejection Record Fields  
Field/Button Name Description 
Reject No.  As with receiving log numbers, this field increments by one each time a rejection record 

is added - it will say “0” until you save the record. This allows each rejection to be 
automatically uniquely identified. 

Reject Date The date that the rejection was issued. It is automatically set to the current date. 
Reject Type This field is used for tracking the type of rejection (such as warning or return for credit). 

You should create a code system for identifying the types of rejections that your company 
normally issues.  
The Reject Type Description will appear to the right of the Reject Type code after 
selecting from the drop down list. 

Disp Code Enter a code indicating the disposition of the material (open, closed, return to supplier, 
scrap, or rework).  
The Disposition code Description will appear to the right of the Disposition code after 
selecting from the drop down list. 

Reject Code Select a Reject code indicating the reject type that pertains to this rejection record, this 
will usually be dependent on the sampling plan that relates to this supplier part. 
The Reject Code Description will appear to the right of the Reject code after selecting 
from the drop down list. 

Auth Date The date on which the supplier authorized the disposition. 
Auth No Authorization number issued by the supplier (if applicable). 
Auth. By The name of the person at the supplier company that authorized the disposition. 

Information entered into this field creates a self-building list.  
Qty Rejected The quantity rejected from this shipment due to this reason (Corrective Action, 

Disposition) 
Qty Returned The quantity of material being returned. 
Qty Scrapped The quantity of material being scrapped or discarded. 
Qty Reworked The quantity of material being reworked or repaired. 
Rejection Cost Fields These fields reflect the breakdown of the costs being charged back to the supplier for the 

reason s specified for this rejection record. 
Currency The default currency symbol is taken from the Supplier Part record for this supplier part. 

It can be edited for each rejection record separately without changing the default entry in 
Supplier Part Entry. 

User Defined 1 and 2 User defined fields that relate to this rejection record. 
Closed Click this radio button to indicate that the rejection notice is closed. 
C A Date The date the Corrective Action Letter was Created and Corrective Action response 

tracking begins 
Close Date The date the Corrective Action is responded to and closed by the Supplier.  
Response I n Days This is calculated by the software. It is the response time difference between the CA Date 

and the Close date in Days.  There are no skip Days / Dates associated in the software for 
the calculation of Response time because it depends on suppliers and elements outside 
of the scope of the software. 

Comments Enter any comments. Remember to press CTRL-ENTER to insert new lines of text into the 
Comments field. 

Rejection Alarm  
The way this alarm feature works, you can set it up so that on the fifth shipment following the rejection, the 
alarm will ask if you need to inspect the next five shipments. By pressing the Yes button, you have accepted the 
alarm, and on the sixth shipment you will be reminded to inspect it.  
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Rejection Notices 
To print a rejection notice for the supplier, click on the Print Rejection Notice button in this screen. After the 
print dialog window appears, click on the checkboxes for either including or excluding the inspection results 
and corrective action statement along with the rejection notice form. If you need to print a batch of rejection 
notices for a number of different suppliers, you can choose Reject Notice from the Listings and Reports 
submenu in the main menu. You can preview rejection notices on-screen before you print them. 

 

 

Example of Reject Notice: 

 

Accept and Reject Tags 
You can print both Accept and Reject tags for identifying incoming materials that have been inspected. Tags are 
designed so that they print one per page (regardless of page size). Since you have complete control over the 
orientation, paper size, and margins, you can, in most cases, use standard off-the-shelf label stock or card 
stock. Before actually printing, you may want to view label on-screen and then experiment with the Print Setup 
settings before actually printing (go to the File menu and select Print Setup). If you need customized tags, 
please contact Technical Support for other options. 
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Accept/Reject Tag Layouts 
There are several tag layouts to choose from, depending on the type of paper stock and printer that you want to 
use. These layouts are explained below: 

Laser—This is designed for use on stock that is ¼ the size of an 8½” x 11” sheet of paper (5½” W x 4¼” L). 
Remember to place your tag into the printer in landscape orientation. 

Dot Matrix—This is designed for use on stock of 4” W x 3” L labels (pin feed roll or fanfold stock). First, you will 
have to set up a User Defined paper size in the Printers icon of the Windows Control Panel. The User Defined 
paper size must match your label’s exact top-to-top length dimension (width is not important). Also, make sure 
you enter the dimensions in 1/100ths of an inch (enter 3 inches as 300). 

 
Next, preview the label within SUPPLIERtrak and use File | Print Setup to set up the User Defined paper size for 
both the Accept and Reject tags. When you close the preview window, you will be able to save the printer 
settings to the program (this only needs to be done once, unless you re-install or update SUPPLIERtrak).  
Field/Button Name Description 
Standard  This layout is 1/3 page (6” W x 2½” L). Place your tag into the printer in the normal (portrait) 

orientation. 
Custom  This is used for custom-designed tags (contact CyberMetrics or your distributor for 

information on custom-designed tags). 

 

Printing Accept Tags 
To print Accepted Material tags, click on the Print Accept Tags button. Next, enter the quantity of tags to be 
printed. To preview tags on-screen before printing, click the View button.  
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Printing Reject Tags 
To print Rejected Material tags, click on the Print Reject Tags button. Next, enter the quantity of tags to be 
printed. To preview tags on-screen before printing, click the View button. 
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Chapter 6:  
Conclusion 

We hope that you’re more familiar with SUPPLIERtrak now and that this guide has helped you understand more 
about how SUPPLIERtrak can help you organize and document your supplier information records. Please 
consult your User’s Manual and System Administrator’s Guide for detailed instructions on other entry screens, 
reports, program setup options, and other features. 
 
If you have any questions about or problems with your software, please contact CyberMetrics Technical Support 
at (480) 922-7300. 



 

 

SUPPLIERtrak  
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Chapter 1:  
Requirements and 
Installation 

You can install SUPPLIERtrak onto your hard drive and optionally place the database on the network.  
This chapter gives you the installation instructions. 

Program Requirements 
SUPPLIERtrak requires the following: 

 Microsoft Windows 98 SE/2000/XP 
 Pentium 800 MHz CPU required; 1 GHz or faster recommended 
 Hard disk with 250 MB of free space for program files and 50-75 MB of free space for typical database 
 256 MB RAM required; 512 MB recommended 
 SVGA or compatible display monitor at 800 X 600 resolution or higher 
 Mouse or compatible pointing device 
 Default Windows Printer (if you want to print reports) 

 
SUPPLIERtrak Network Requirements: 

 Optional: This section will only apply if the data file will be shared over the network or will be 
part of a regular network backup. 

 Network folder with full rights for each SUPPLIERtrak user 
 100 MB LAN 

Upgrading 
If you are upgrading from an older version of SUPPLIERtrak, perform the program installation as described in 
the next section, then refer to the “Data Transfer Utility” in the Appendix for details on transferring your current 
database records to this version of SUPPLIERtrak. 

Program Installation 
Installing SUPPLIERtrak 

 
Note: If Auto Run is enabled on your computer, the Setup program will run automatically and you can skip to 
number 5 below. 

 
2. Close out of all other programs, and click the Windows Start button.  
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3. Select the Run... command. 

 
4. Place the SUPPLIERtrak CD into your CD-ROM drive. Next, click Browse... and Browse for the CD-

ROM drive letter. Select SETUP.EXE from the file listing. It will appear in the Open field of the Run 
box. You can also type the drive letter and file name here. 

The example here shows the D: drive as the CD-ROM drive, with Setup file selected. 

 

5. Click the OK button. 
6. Follow the setup instructions on the screen. 
7. By default, the program will be installed to the C:\Program Files\SPW46 directory. If you 

experience problems during installation, please see the Trouble Shooting section in the Appendix. 

Network Installations 
If you want your database file to be stored on a network drive, then do the following before running 
SUPPLIERtrak for the first time (repeat these steps for each workstation installation): 

1. Install the program to the workstation’s local hard drive, as described above. 
2. Create a data directory on the server (the directory name should still be SPW46. Make sure the 

workstation user has full rights in the directory). 
3. Move the SPDATA46.MDB file from the workstation’s local SUPPLIERtrak program directory to the 

network server‘s data directory that you created in Step 2. 
4. Run SUPPLIERtrak for the first time, go to the File menu, and then select Open Database. Browse 

to the folder SPW46, then the SPDATA46.MDB file on the server.  
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Running SUPPLIERtrak 
To run SUPPLIERtrak, execute the SUPPLIERtrak icon in the SUPPLIERtrak Program Group or double-click the 
SUPPLIERtrak shortcut icon on your Windows Desktop. 

 

Starting SUPPLIERtrak from the Start Menu  
1. Click the Start button. 

 

2. Select Programs. 

 

3. Select the SUPPLIERtrak 4.6 program group. 
4. Then choose SUPPLIERtrak 4.6. 

SUPPLIERtrak Logon 
When you run SUPPLIERtrak, a log on window may appear, as shown here (only if you have set up security): 

 

 
Enter your PIN number and click the OK button. See the section on User Settings for more information about 
setting up this security feature.  

SUPPLIERtrak Serial Number 
If you have not entered your program serial number into the About box, the following message screen will 
appear to remind you to enter it. 
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Click the OK button, and the About window will appear. Enter the serial number for your copy of SUPPLIERtrak 
(the serial number is located in your manual or on the packing list that came with your package). If you cannot 
locate your serial number, please contact CyberMetrics Technical Support at (480) 922-7300. 

 
The About window, shown above, gives you information about the current number of users that have been set 
up, in addition to information about your number of records. 

 

SUPPLIERtrak Main Menu 
The SUPPLIERtrak main menu is shown below. Note that the name of the currently logged-in user is displayed 
towards the lower left corner. The full path to the currently open data file is displayed in the lower right corner. 
SUPPLIERtrak’s Outlook style interface is easy to learn and use, with clean, clear graphics and an intuitive 
approach that makes extensive training sessions and manuals unnecessary. 

 

 
To add, change or delete records, click on the Main Records icon or the Ratings and Surveys icon. To view or 
print reports, click on the Reports icon. To view or print Graphs, click on the Graphs icon. To configure 
SUPPLIERtrak, and set up users click on the Setup icon.  To edit your data tables, archive/un-archive records, 
click on the Data Tools or Utilities icons. To exit the program, click on File | Exit. 

 
Important: To view information about what version of the program you have, your serial number, 
information about your computer and operating system, and how many records are in your SUPPLIERtrak 
database, select the About menu item under the Help menu. 
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This table shows how the different SUPPLIERtrak menus are organized.  
Menu Button Options 
Main Records Supplier Entry 

Supplier Part Entry 
Received Material Entry 
Procedure Entry 
Staff Entry 

Ratings and Surveys Ratings Entry 
Survey Entry 

Reports Supplier Reports 
Part Reports 
Received Reports 
Rejections Reports 
Survey and Rating Reports 
Miscellaneous Reports 
Inspection Reports 
Staff Reports 

Graphs Part Comparison Chart 
Supplier Performance Chart 
Supplier Comparative Chart 
Worst Supplier Chart 

Setup Settings 
Rating / Survey Wizard 
Setup Users 
Report Control ID Entry 
Ratings Definition 
Survey Definition 

Data Tools Backup/Restore 
Import/Export 
Compact/Repair Data 
Modify License 

Utilities Archive/Un-Archive Receiving Data 
Archive/Un-Archive Suppliers 
Edit All Tables 
Reset Early / Late 
Update Supplier Next Rating Due 

 
If you installed to a directory other than C:\Program Files\SPW46, or the program cannot find your database file, 
then the Where Is The Data File? window will appear. In this case, you will need to tell SUPPLIERtrak where to 
find the database file named “SPDATA46.MDB”. The Where Is The Data File? window is shown below:  

 
Note: Users who have their database file located on the network server must be logged into the network 
operating system before they can open the database file. 
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If this window appears, click the local or network directory under the Look In box, and then navigate through the 
folders to the database location. Choose the database file name, “SPDATA46.MDB”, so it will appear in the File 
Name dialog box, and click Open. The database should then successfully connect. 

SUPPLIERtrak Settings 
To enter your company name and insert a logo, go to Setup and select Settings.  
 
You can also Enable an Audit Trail, Format Reports and change the Default Corrective Action Statement in 
Settings. 
 
Please see the Tools and Utilities chapters for information on Settings. 

Database Security 
When you select Set Up Users from the Settings menu, the User Entry screen will appear.  
 
The Set Up Users feature allows you to add new SUPPLIERtrak users and set each one’s rights for each of the 
program areas. User Information, Record Access and Security are found in the Utilities section of the manual. 

Date Formats 
SUPPLIERtrak supports all of the available numeric date formats within Windows. For example, you can 
represent the date of November 1, 2002 as: 11/1/02, 11/01/02, 11/1/2002, 02/11/1, 02/1/11, or 2002/11/1, depending on 
your preference. As a precaution, you may wish to verify the date settings in Windows Control Panel. The date 
formats that are entered into SUPPLIERtrak must match the Windows Control Panel date setting; otherwise, 
errors will occur while you’re running the program. 
 
Begin by clicking the Start button, go to Settings, and then select the Control Panel. Double-click on Regional 
Settings icon, and then click the Date tab. 

 
Place your cursor in the Short Date Style field, click the arrow, and select a format with a four-digit year, such 
as M/d/yyyy or MM/dd/yyyy. 
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Chapter 2: Program 
Conventions 

To save time and provide consistency, the program uses certain operational conventions. You should try to 
become familiar with these conventions before you begin using the software. Conventions are used for 
navigating through records, adding new records, editing existing records, and deleting records. Other 
conventions are used for retrieving and printing records. Shortcut keys are also available to save data entry 
time and avoid mistakes. Rather than repeating the same information in each section of this manual, these 
program conventions and others are described only in this section. Other sections of this manual (those that 
deal with the various records) will explain each record’s purpose, its fields, special purpose buttons, and any 
other record-specific information. 

Record Search Windows 
Use the record search windows to find a subset (also called dynaset) of records that match the criteria you 
enter. Although this may not seem useful at first, you will later find this feature to be quite valuable when you 
have several hundred (or several thousand) records from which to select. 
 
If you simply want to search all records, then leave all of the search fields blank and click the Find button. 
 
For example, you may want to view only suppliers that have a name exactly equal to “Acme”. In this case, you 
would enter “Acme” into the supplier name search field. Similarly, if you wanted to search for all suppliers that 
started with “Acme” (such as “Acme Plastics”, “Acme Stamping”, and “Acme Electronics”) then you would enter 
a search value of “Acme*”. The asterisk (*) character is a wildcard character, which indicates, in this example, 
that you want all supplier records that have a name starting with the word “Acme”. Likewise, if you enter 
“*Electronics”, then this would tell the program that you want all suppliers ending in the word “Electronics”. 
Furthermore, if you enter “*Plastics*”, then this would tell the program that you want all supplier records 
containing the word “Plastics”. You can specify as many search fields as you wish, depending on how selective 
you want the search operation to be. If you enter any criteria in a given filter field, SUPPLIERtrak will return all 
records that match that criteria for that field and also all records where that field is NULL (empty). This 
capability does not extend to Date (To and From) fields in the Filter forms.  
 
Other wildcard characters besides the asterisk are supported. Shown below is a complete list of all wildcard 
characters supported in search fields: 

Supported Wildcard Characters in Search Fields 
The asterisk (*), question mark (?), number sign (#), exclamation point (!), hyphen (-), and brackets ([ ]) are all 
considered wildcard characters. You can use these characters in record searches and Find/Replace commands 
to include all records that begin with specific characters or match a certain wildcard pattern.  
 
Shown below are some wildcard character examples:  

Wildcard  
Character  

Example  
Search/Find Example of What Would Be Found 

* wh* Finds what, white, and why; works like MS-DOS commands 
* *at Finds cat, bat, and what 
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Wildcard  
Character  

Example  
Search/Find Example of What Would Be Found 

* */*/2000 Finds records with any date in 2000  
Note: The date format you enter in the filter must match your Windows date 
setting. 

* 11/*/* Finds records with any date in the month of November 
? b?ll Finds ball, bell, and bill; this symbol matches any single character 
# 1#3 Finds 103, 113, 123; matches any single digit (not for use with date fields - 

use asterisk (*) character instead) 
[ ] b[ae]ll Finds ball and bell, but not bill; matches any single character within the 

brackets. This is useful if you want to find records that contain wildcard 
characters (i.e., it allows a literal search on wildcard characters; for 
example, to find “Machine #1”, you would enter “Machine [#]1”). 

! b[!ae]ll Finds bill and bull, but not bell; matches any character not in the list 
between the brackets 

- b[a-c]d Finds bad, bbd, and bcd; matches any one of a range of characters 

Floating Toolbar  
To make using basic commands easier, common program functions have been placed on a floating toolbar. The 
tool bar allows you to perform a variety of tasks. You can move the toolbar by clicking on its title bar and 
dragging it to any desired location. If you do not want the tool bar to display, you can disable it by clicking the  
in the corner of the toolbar. To display the toolbar again, click on the View menu at the top of the screen and 
choose Show/Hide Toolbar.  

Shown in Horizontal Mode 

Repositioning the Toolbar: 
To move the toolbar, click its title bar and drag it to its new location. 

Resizing the Toolbar: 
Click one of the edges of the toolbar and drag it to the desired size.  

Button Description 

 

Form View Click this button to display your records in Form view (the default presentation of your 
records). In Form view, you can see all of the fields for a record, but you can see only one 
record at a time. 

 

Table View To display your records in a tabular format, click this button. Table views allow you to view 
many records at a time (available only in certain record entry screens). 

 

Find Use this command to search for specific information. Place your cursor in the field 
containing the category by which you want to search, and then click this button. The Find 
window opens, and you can enter the information that you want to locate. 

 

Find Next After you’ve closed the Find window, click the Find Next button to locate the next instance 
of the information for which you’re searching. 

 

Replace Place your cursor in the field containing the information you want to replace. The Replace 
window will prompt you for Find What and Replace With. You can replace any or all 
occurrences of the same information. 

 

Filter Records Use this button to re-open the filter window for the record window. You can then filter for a 
group of records that match the criteria you enter. 

 

Sort Ascending Select this button to sort all of your records in ascending order (numbers show before 
letters). 

 
Sort Descending Click this button to sort all of your records in descending order (numbers show after 

letters). 

 

Undo Click this button to undo your changes to the current record. 
 

 

New Record Use this button to add a new record. 



 SUPPLIERtrak™ User’s Manual 

 

61 

Displaying Complete Fields 
Although you can enter a large number of text characters into some of your entry fields, your forms and reports 
may not be able to display the complete contents of every field. In the entry screens, you can view the complete 
field contents by pressing SHIFT-F2 (this displays a pop-up Zoom window).  

 
Also, you can view your records in Datasheet mode and widen the column widths to an appropriate width. 

 
 

 

Pop-Up Calendar for Date  
The pop-up calendar feature allows you to enter dates by choosing them from a calendar instead of 
manually typing them. Whenever you are entering information in a filter form or a data entry form, 
you can double-click on the date field to view the calendar (this only works in date fields). When the 
calendar first appears, it will display the current date. To select another date, click the up or down 
arrow buttons to scroll to the desired month and year, then click the day of the month. Click the OK 
button to accept the date; otherwise click the Entry Fields Cancel button. 

 

Form Views 
After you enter any optional filter fields in the Filter window, the program will search the database and present 
the first record it finds in a record form. Form views of records allows you to see only one record at a time, 
whereas Table (also called “Datasheet”) views allow you to see many records at a time (i.e., each row 
represents a record and many rows (records) are displayed at once). 
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Example of Supplier Record in Form View 

 

Elements of a Record Form 
All record forms have the following common elements: 

Form Title Bar 
Located at the top of each form, it contains the title of the current form (Supplier Master Entry in the above 
Form View example). You can move the form by clicking on the title bar and then dragging it to a new location. 

Menu Bar 

 

Located above the title bar of each form, the menu bar typically has menus for File, Edit, View, Records, and 
Help. To select a menu, click on the menu title, and a drop-down list of menu items will appear. Some menu 
items may not be available. “Unavailable” menu items are not appropriate in Form view. 

Control Menu Icon   

 

This icon is located to left of the title bar. If you click on this icon, a menu will appear, 
allowing you to manipulate the form’s size and location. This also allows you to close 
the form. 

Record Selector Bar 

 

  
This is a vertical bar located on the left side of the form. You can use it to select the entire 
record for subsequent copying or deletion. You can also use it to save any changes made to 
the record.  

 

If any fields have been changed on the form, an icon of a pencil will appear on the bar - 
indicating that you can click on the bar to write your changes to the database. 

 

  
When the bar appears a darker gray with the arrow, this means the record has been saved or 
selected. 
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Record Selector Bar Symbols 

 Current Record 

 New Record 

 Record changed but not saved yet 

 Record locked and in use by another user 

Navigation Buttons 

 

Navigation buttons are used to navigate back and forth through your records. They are located in the bottom left 
corner of the form. The five buttons have arrows on them that indicate each one’s navigation direction:  

 First Record 

 Previous Record 

 Next Record 

 Last Record 

 New Record 

Record: Allows you to type in the record number that you want to go to.  

Navigation Panel 
The navigation panel is located in the upper right portion of the form. It has record navigation buttons, but also 
has extra buttons for commonly used operations, such as:   

 

New - For starting a new record (presents a blank form to be filled in). 
 
Delete - Deletes the record currently shown in the form. 
 
Close - Saves any changes, closes the form, and returns to the main menu. 

Scroll Bars 
 

 
Scroll bars may be displayed on the right, bottom, or both sides of a form. Scroll bars 
are used to scroll to portions of the form that are not currently visible (this can happen 
if you reduce the form to a size that is smaller than the form’s original design). 

Maximize/Minimize Buttons 
 

 These are buttons located in the upper right corner of the form. They are used to either maximize 
the form’s size to largest size allowed (click the up arrow or the square with the top border) or to 
minimize the form to an icon (click the down arrow or the short horizontal line). If you maximize the 
form, then only one button is displayed, having both an up and down arrow. Click on this button to 
return the form back to original size. If you minimize the form, then it turns into a Form icon. 
Double-click the Form icon to return it back to original size. 

List Box Buttons 
 

 

These are buttons that indicate that a list of items is available to choose from. When you 
click on the button, it presents a list of items in a scrollable box. Click on any item shown in 
the box to select it. 
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Datasheet Views of Records 
Datasheet view allows you to see many records at a time. Datasheets operate much like spreadsheet programs. 
Each row represents a record, and each column represents a field. Records can be viewed, added, and changed 
in Datasheet views. Datasheets offer more flexibility in that you can resize column widths and row heights, 
rearrange column positions, hide columns, and even change the fonts. Datasheets can be a more efficient 
interface for adding or modifying your records. One drawback of Datasheet views, however, is that they cannot 
display the related records in an embedded datasheet (i.e., the Form view of supplier master records contains 
an embedded datasheet of part records for that supplier - you can see both supplier record and part records in 
a single window). 
 
Since the program automatically presents records in Form view, you’ll need to select the View menu from the 
top menu bar and then choose Datasheet to place your records in Datasheet view. 

Example Datasheet View of Supplier Records 

 

Elements of a Datasheet Window 
All datasheet windows have the following common elements: 

Datasheet Title Bar 
Located at the top of each datasheet, it contains the title of the datasheet. You can move the datasheet window 
by clicking on the title bar and then dragging it to the new location. 

Menu Bar 
Located above the datasheet title bar, the Menu bar typically has menus for File, Edit, View, Records, and Help. 
To select a menu, click on the menu title, and a drop-down list of menu items will appear. Some menu items 
may not be available (they will have a “gray” appearance).  

Control Menu Icon 
This icon is located to left of the title bar. If you click on this icon, a menu will appear, allowing you to 
manipulate the datasheet’s size and location. It also allows you to close the datasheet window. 

Record Selector Button 
This is a small rectangular button located on the leftmost side of each row. You can use this button to select the 
entire record for subsequent copying or deletion. You can also use it to store any changes made to the record (if 
any record’s fields have been changed, an icon of a pencil will appear on the button - indicating that you can 
click on the button to write your changes to the database). You can select multiple records by clicking and 
dragging your mouse pointer over the desired records. To select all records between two records, first click on 
the first record, then hold the SHIFT key while you click on the last record. All records between the first and last 
will be selected. A selector button with an asterisk (*) indicates on it that this is a new record position (always 
located at the bottom of the datasheet). 

All Records Selection Button 
This is a small rectangular button located on the upper left portion of the datasheet, just below the control 
menu icon. Click this button to select all records in the table. 

Column (Field) Selector Buttons 
These are small rectangular buttons located at the top of each column. The name of the field that the column 
represents is labeled on each button. When you click on one of these buttons, the entire column is selected and 
an operation, such as moving the column or hiding the column, can be performed.  

Note: The contents of one column cannot be copied or moved to another column. 

Navigation Buttons 
Navigation buttons are used to navigate back and forth through the records in the datasheet. They are located in 
the bottom left corner of the window. Each of the buttons has an arrow on it that indicates the navigation 
direction. 



 SUPPLIERtrak™ User’s Manual 

 

65 

Scroll Bars 
Scroll bars may be displayed on the right, bottom, or both sides of the datasheet. The vertical (up/down) scroll 
bars are used to scroll to different records. The horizontal (left/right) scroll bars are used to scroll to portions 
of the datasheet that are not currently visible. 

Maximize/Minimize Buttons 
These are buttons located in the upper right corner of the datasheet. They are used to either maximize the 
datasheet’s size to largest size allowed (click the up arrow or the square with the top border) or to minimize the 
datasheet to an icon (click the down arrow or the short horizontal line). If you maximize the datasheet, then only 
one button is displayed, having both an up and down arrow. Click on this button to return the datasheet back to 
original size. If you minimize the datasheet, then it turns into a Datasheet icon. Double-click the Datasheet icon 
to return it back to original size. 

Saving Datasheet View Changes 
Changes to datasheet attributes, such as column widths, displayed/hidden columns, column locations, 
gridlines, and fonts can be saved. The program will prompt you to “Save Changes to Form?” when closing a 
datasheet that has been modified. 

Printing Datasheets of Records 
Printing is allowed while in either Datasheet or Form view. To print, select Print from the File menu. Print Setup 
and Print Preview can also be chosen from the File menu. These commands, combined with the Filter/Sort 
command, will prove useful when you’re designing custom datasheet reports. 

Hiding and Displaying Columns 
You can temporarily hide columns while in Table view. This is useful for removing extraneous data from the 
screen and for reducing the report’s width when you’re designing a custom report. 

To Hide Columns: 
1. Click anywhere in the column, or click the field selector of the column (located at the top of the 

column) you want to hide. To hide multiple columns, drag across the field selectors. 

2. From the Format menu, choose Hide Current Column. 

To Display Hidden Columns: 
 

 

1. From the Format menu, choose Show/Hide All Columns. 
2. In the Columns box, select the column you want to hide by clicking that box. To 

Unhide columns, click the box beside the column and a checkmark will appear.  
3. When you have selected all the columns you want, click the Close button. 

Changing the Font in Table View 
You can change the typeface while in Table view mode. You can change the font, font size, style, and also add 
options, such as underlining. Changes will not affect the Form view of your records. 
To change the font: 

1. From the Format menu, choose Font. 

2. Select changes to be made from the Font Change window. 

Hiding and Displaying Gridlines 
By default, the program displays gridlines around each field cell while in Table view. You can hide the gridlines 
by choosing Gridlines from the Format menu. A checkmark will appear if gridlines are active. 

Changing the Row Height 
Choose Row Height from the Format menu. This changes the height of all rows in a datasheet. 

Changing the Column Width 
Choose Column Width from the Format menu. This changes the width of the selected columns in a datasheet. 

To Freeze Columns 
Choose Freeze Columns from the Format menu. This freezes the selected columns on the left side of the 
window to prevent them from scrolling off the screen. If no columns are selected when you choose this 



 Chapter 2: Program Conventions 

 

66 

command, the column containing the insertion point will be frozen. New frozen columns are added to the right 
of existing frozen columns. A bold line separates the frozen and unfrozen columns. 

To Unfreeze Columns 
Choose Unfreeze Columns from the Format menu. This unfreezes all frozen columns. When you unfreeze 
columns, they remain in the same order they were in while frozen. You cannot unfreeze specific columns; you 
can only unfreeze all frozen columns. 

Output To Command 
The Output To command from the File menu allows the output of reports to a text file, Microsoft .RTF file, or 
Microsoft Excel spreadsheet file. If you save a file in .RTF format and then open that file in a word processing 
application, such as Microsoft Word, your data appears in a formatted table. When you save the output in .XLS or 
.RTF format, it includes fonts, layout, and other formatting elements. The output does not include sub forms 
and sub reports. This is a great way to chart your data. See the Microsoft Excel manuals for working with Excel 
and creating charts. 
 
You can easily analyze receiving records with Microsoft Excel. For example:  

 
Step 1.  From the main menu, select Received Material Entry. Enter any search criteria in the Receiving Entry 

search window and select the Find button. 

Step 2.  The Received Material Entry screen will appear. Select File | Output To... from the menu. 
Select Microsoft Excel (*.xls) from the Output To dialog. Give the output a file name.  
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Step 3. Open the created .XLS file in Microsoft Excel. 

 

Send Command (E-mail Reports) 
The Send command from the File menu allows the output of reports to Microsoft Outlook (or any MAPI 
compatible e-mail program). When you save the output in .XLS or .RTF format, it includes fonts, layout, and 
other formatting elements. 

 

Select Record Command 
You can use the Select Record command from the Edit menu item to select (highlight) the current record, 
allowing you to work with it as a whole. For example, you can select a record you want to copy into the 
clipboard. 

Select All Records Command 
You can use the Select All Records command from the Edit menu item to select (highlight) all records in a form 
or datasheet so that you can work with them as a group. For example, you can select all the records in one table 
and then copy them to another table. 

Find Command 
While in Form view or Datasheet view, the Find command is available via the pull-down Edit menu. You could 
use the Find command to search for a certain record or group of records – for example, you could search the 
database for suppliers located in a certain state or for suppliers that shipped to you last month. 
 
You can search for any text string, including a phrase, a word, or part of a word. You can also use wildcard 
characters to make the search more general. For the fastest searches, search for the first few characters 
within a single field.  
 
Because the Find dialog box remains on the screen during searches, you can find as many records as you want 
without having to choose the Find command repeatedly. If necessary, drag the box out of the way to see your 
records. 

To find data: 
1. Display the datasheet or form for the records you want to search. 
2. Select the field (column) you want to search, unless you intend to search all fields. Searching a 

single field is faster than searching in all fields. 
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3. From the Edit menu, choose Find. The program displays the Find dialog box. 

    
4. In the Find What box, type the text you want to find. Use wildcard characters to make your search 

more general. 
5. Set other Find dialog box options if necessary. 
6. To find the first occurrence of the text, choose the Find First button. To find the next occurrence of 

the text and all subsequent occurrences, choose the Find Next button. 
7. When you’ve finished, click the Close button. 

Replace Command 
While in either Form or Datasheet views, the Replace command is available via the Edit menu. Within a 
database table, you can search for and replace all or some occurrences of a specified text string, including a 
phrase, a word, or part of a word. You can use wildcard characters to make the search more general. For 
example, you might want to change all occurrences of the word “bolt” to “washer” in a part description field. 

To replace data in a table: 
1. Display the datasheet or form containing the record data you want to replace. 
2. Select the field (column) in which you want to replace data, unless you intend to search all fields. 
3. From the Edit menu, choose Replace. The program displays the Replace dialog box. 

 

4. In the Find What box, type the text you want to find. If you use wildcard characters, you may want 
to confirm text replacements to ensure the replacements are correct. 

5. In the Replace With box, type the replacement text. 
6. Under Search In, select Current Field or All Fields. If you select Current Field, the program 

searches for data in the field in which the insertion point is located. 
7. Set other Replace dialog box options if necessary.   

You can confirm each replacement, or you can replace all occurrences without confirmation.  

To confirm each replacement: 
1. Choose the Find Next button to find the first occurrence of the text. The program finds the first 

occurrence of the text and highlights it. 

2. Choose the Replace button to replace the highlighted text with the text in the Replace With box. If 
you don’t want to replace this occurrence of the text, choose the Find Next button to find the next 
occurrence. 

To replace all occurrences without confirmation:  
Choose the Replace All button. 
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Quick Sort Command 
You can use the Quick Sort command from the Records menu to perform a simple sort of the records based on 
the currently selected field or fields. A sub menu is displayed that enables you to sort in ascending or 
descending order. The sorted records return to their original order when you close the form (or table). 

Ascending: A-Z or 0-100 

Descending: Z-A or 100-0 

 

Filter/Sort Command 
You can use the Edit Filter/Sort command to sort records in either Form or Datasheet view modes. Sorting  
can be done in ascending order (A-Z, 0-100) or descending order (Z-A, 100-0). The sorted records return to their 
original order when you close the form (or datasheet). 

To Sort Records: 
1. Choose the Edit Filter/Sort option from the Records menu. The Filter window appears with a list of 

available fields. 

 

2. In the Field row in the filter window’s grid, add the fields for which you want to specify a sort 
order. You can drag fields from the field list, or you can click a cell in the Field row, then click the 
drop-down arrow, and choose a field from the list. 

3.  For each field whose data you want to sort, click the drop-down arrow in the Sort row to select a 
sort option. If you sort on multiple fields, the program sorts on the fields you specify in order from 
left to right.  
 Note: You can also sort on a hidden field. 

5. Select Apply Filter/Sort in the Records menu (this menu is available while the Filter window is 
open). Alternately, you can also choose Apply Filter/Sort from the Records menu. 
 

To undo a sort, click on the floating toolbar Filter button and clear the filter values. Then click on the Find 
button. 

 
Entering Filter Criteria 
In addition to sorting, you can enter a criteria expression to show only those records that match your specific 
conditions. Criteria expressions are entered into the Criteria cell row and, optionally, into the OR cell row. If 
using field names in the criteria expression, then choose only those fields displayed in the field list (field names 
must be spelled exactly as shown). 



 Chapter 2: Program Conventions 

 

70 

Criteria Expression Examples  
Field  Example Expression Records That Are Found 
Supplier Code “100-*” Suppliers with codes starting with “100-” 
Supplier Code “100-*” or “200-*” Suppliers with codes starting with “100-”or with”200-” 
Receive Date = #3/2/00# Parts received on March 2, 2000 
Receive Date Between #3/1/00# And #3/31/00# Parts received between the 1st and 31st of March, 2000 
Description In (“Bolts”, “Washers”) Parts that are bolts or washers 
Description Not “Bolts” Parts other than bolts 
Receive Date < Date( ) - 30 Parts received over 30 days ago; Date() represents the current 

(today’s) date 
Receive Date Year([Receive Date]) = 2000 Parts received in 2000 
Receive Date DatePart(“q”, [Receive Date]) = 4 Parts received in the fourth calendar quarter 
Description Like “C*” Parts whose descriptions start with the letter “C” 
Description Like “*1 Inch” Parts whose descriptions end with “1 Inch” 
Description Like “[A-D]*” Parts whose descriptions are between A and D 
Supplier Code Right([Supplier Code],2) = “99” Supplier Codes that have “99” in the last two field positions 
Description Is Null Parts whose descriptions are null (blank) 
Description Is Not Null Parts whose descriptions are not null (not blank) 

Adding New Records 
Adding Records while in Form View 

To add new records in Form view you can: 

1. Click on the New  button in the floating toolbar. 
or 

2. Click on the Last Record  navigation button, then click on the Next Record  navigation button. 
or 

3. Use the keyboard shortcut: CTRL + 
 
Enter the information into the record and then repeat either of the above steps to add another new record. 

Adding Records while in Table View 
To add new records in Table view you can: 

1. Click on the Last Record navigation button, and then click on the Next Record navigation button. 
or 

2. Scroll to the very bottom row (the record selector button will have an asterisk shown on it). 
 

Enter the information into the record and then repeat either of the above steps to add another new record. 

Go To Command 
You can use the Go To command from the Records menu to quickly move to different records. A sub menu is 
displayed with choices that help you navigate through your records. 

First: Moves the insertion point from a field in the current record to the same field in the first record. 

Last: Moves the insertion point from a field in the current record to the same field in the last record. 

Next: Moves the insertion point from a field in the current record to the same field in the next record. 

Previous: Moves the insertion point from a field in the current record to the same field in the previous record. 

New: Moves the insertion point to the blank record at the end of your form or datasheet, allowing you to enter a 
new record. 
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Show All Records Command 
You can use the Show All Records command from the Records menu to display the most current records in a 
form or datasheet. This command removes a filter if one is currently applied (including a sort created with the 
Quick Sort command). It requires the underlying records to display the most current data and moves to the first 
record. 

Copying Records 
You can easily copy records to save time and reduce mistakes. However, remember that certain records require 
that certain fields must be unique. In these cases, go ahead and copy the record, but make sure that the new 
record has the required unique fields before saving (otherwise you may get an error message). 

To copy a record: 
1. Go to the record you want to copy and click on the record’s selector bar (or button). 
2. Choose Copy from the Edit menu (or press CTRL-INS on your keyboard). 
3. Go to a new record. 
4. Click on the new record’s selector bar (or button). 
5. Choose Paste from the Edit menu (or press SHIFT-INS on your keyboard). 

Deleting Records 
To delete records, do the following: 

1. Go to the record you want to delete and click on the record’s selector bar (or button). 
2.  Choose Delete from the Edit menu, click on the Delete button in the Navigation Panel, or press 

the DELETE key on your keyboard. 
3. You will be asked to confirm the deletion (in certain cases you will be asked twice). 

 
In Datasheet views, more than one record can be deleted by selecting more than one record. Use the record 
selector buttons to select all the records to be deleted, and then perform Steps 2 and 3. 

Undoing Changes to Fields and Records 
If you want to undo changes to a field (and you have not yet left the field) either press the ESC key on the 
keyboard, or select Undo Current Field from the Edit menu. 
 
If you have changed more than one field on a record and want to undo all the changes to the record, then select 
Undo Current Record from the Edit menu. If you are still in one of the fields that have been changed, then you 
will first have to select Undo Current Field and then select Undo Current Record from the Edit menu. 

Saving Records 
Although records are automatically saved whenever you go to a different record or close the form (or 
datasheet), you may choose to manually save records by clicking on the record selector bar (or selector button 
if in Datasheet view). You can also select Save Record from the File menu in the top menu bar. 

Editing and Shortcut Keys 
Listed below are some keyboard shortcuts that you can use to save time when you are entering records. 

 
Note: Where indicated by “CTRL”, hold down the CTRL key while pressing the other key: 

Keyboard Shortcuts – General  
Press To do this 
PAGE DOWN Go to next record in Form view (next page of records in Table view) 
PAGE UP Go to prior record in Form view (prior page of records in Table view) 
CTRL PAGE DOWN Go to next record, but keep cursor in same field 
CTRL PAGE UP Go to prior record, but keep cursor in same field 
CTRL ‘ Copy field data from the prior record’s field 
CTRL ; Insert the current date 
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Press To do this 
CTRL : Insert the current time 
CTRL + Add a new record 
SHIFT ENTER Save changes to the current record 
CTRL - Delete the current record 
CTRL ENTER Add a new line to a memo field 
F2 Switch between field editing and navigation modes 
F5 Move to the record number entry box 
SHIFT SPACE Select the current record 

 

Field Editing and Selection Keys  
Press To do this 
SHIFT RGT ARROW Extend the selection or deselect one character to the right 
CTRL SHIFT RGT ARROW Extend the selection or deselect one word to the right  
SHIFT LFT ARROW Extend the selection or deselect one character to the left 
CTRL SHIFT LFT ARROW Extend the selection or deselect one word to the left  
CTRL C or  
CTRL INSERT 

Copy the selection into the Windows Clipboard  

CTRL V or  
SHIFT INSERT 

Paste text from the Windows Clipboard 

 

Datasheet (Table) Keyboard Shortcuts  
Press To do this 
TAB, ENTER, or  
RGT ARROW 

Move to the next field 

END Move to the last field in the current record (Table view) 
SHIFT TAB or  
LFT ARROW 

Move to the previous field 

HOME Move to the first field in the current record (Table view) 
DN ARROW Move to the current field in the next record 
CTRL DN ARROW Move to the current field in the last record 
CTRL END Move to the last field in the last record 
UP ARROW Move to the current field in the previous record 
CTRL UP ARROW Move to the current field in the first record 
CTRL HOME Move to the first field in the first record 
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Chapter 3: Supplier 
Master Records 

Use supplier master records to store information about your suppliers. Each supplier needs a unique code 
number (the code can include both numbers and letters). Each supplier requires a code number because: 

1. Some suppliers may have the same name (or very similar names). A code number will help 
prevent ambiguity and mistakes. 

2. Larger suppliers can have the same name, but may ship from multiple plants or divisions. You will 
probably want to track each supplier’s shipping location separately. 

 
Due to the relational hierarchy of the SUPPLIERtrak database, supplier master records must be created before 
you can enter receiving records, supplier part records, rating records, and survey records. 
 
To enter supplier master records, select Supplier Master Entry from the Enter/View Records menu. Next, enter 
any search fields (just click the Find button if you are entering new records).  
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The record entry form will appear, showing your first record. Click the New button on the upper right corner of 
the screen to add a new record. If you are looking for a certain record, use the navigation buttons to scroll 
through the records, or use either the Find or Edit Filter/Sort options in the Record menu. 

 

Supplier Master Record Fields 
The following fields are used in the supplier master record:  
Field/Button Name Description 
Supplier Code  A unique alpha/numeric identification entry that must be placed in a record in order 

to store it. Of course, you will have to develop a numbering system. Important: To 
ensure proper sorting of records, you should make sure that all supplier codes are 
the same length. For example, do not use codes like A-1, A-2, A-100; instead, use 
codes that are the same length, such as A-001, A-002, A-100. Try to keep your coding 
system simple. 

Supplier Name  The name of the supplier company. 
Contact The name of the contact person at the supplier company. 
Phone The telephone number of the supplier. 
Address  The street address of the supplier company. 
City The city of the supplier company. 
State The state (or province) of the supplier company. 
Zip The zip code (or postal code) of the supplier company. 
Country The country of the supplier company (optional). 
Last Survey The date of the last Survey. 

Can be entered manually, but also is updated by the software. 
Last Rating The date of the last Rating 

Can be entered manually, but also is updated by the software. 
Last Received The date of the last Receiving Record. 

Can be entered manually, but also is updated by the software. 
Last Reject The date of the last Reject Record. 

Can be entered manually, but also is updated by the software. 
Enabled Is this Supplier current, But not yet archived? 
Supplier User 1 and 2 User defined fields that relate to this particular Supplier. 
Rating Frequency At what interval does a Rating have to be completed for this Supplier? 
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Field/Button Name Description 
Rating Frequency UOM Enter the frequency of rating, using the unlabeled list box field on the right for the 

frequency units (for example, “45 DAYS”). When the software calculates the next 
rating due date, it uses this value.  
Your choices for the Units field are explained below:  
Days—schedule is based on elapsed calendar days  
Weeks—each week equals seven days; schedule is based on elapsed calendar weeks  
Months—schedule is based on elapsed calendar months  
EOM—rounds the next due date to the end of the month in which it occurs. For 
example, “6 EOM” means every 6 months, but the program extends the due date to 
the end of the sixth month (or the last working day of the month if you’re using skip 
days – see the System Administrator’s Guide for more information)  

    Years—each year equals 365 days; schedule is based  on                       elapsed 
calendar years 

Next Rating Due The next Rating due date, entered manually or calculated by the software. 
Parts Table This is an embedded table of supplier part records.  

Supplier Rating History 
 This tab will display a sub form of the details of this supplier’s historical rating. 

 

 

Supplier Procedures 
If needed, you can set up receiving inspection procedures for suppliers. These procedures can be shared with 
many suppliers or can be specific to one supplier. For example, you may have special tests that must be done 
on all incoming materials from a certain supplier (supplier-specific procedures). On the other hand, you may 
have other tests that must be done on incoming materials from a certain group of suppliers (shared 
procedures). 
 
If the inspection procedure is part-specific, then you’ll need to Select the part procedure into the Supplier Parts 
Entry form. 

Note: If you’re entering a new supplier record, then make sure that you first save the supplier record (i.e., 
click on the record selector bar on the left side of the form or do a PAGE DOWN/PAGE UP sequence on the 
keyboard) before attempting to enter a procedure record.  
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To select supplier procedures, click on the Procedures tab, and a procedure entry sub form will appear. Select 
the procedure name and then the text of the procedure (there is no limit to the number of lines of procedure 
text) will appear below. If you want to use a procedure that you entered previously on another supplier, then use 
the same procedure name.  

 
On the Procedures OLE tab of this window is the OLE Box field. “OLE” stands for Object Linking and Embedding. 
This means that you can view any linked valid Windows object (such as a graph, picture, or digitized movie) that 
has been entered into this field when the procedure was created in procedure Entry.  
 
Also in this sub form is the Attachments tab. This allows you to view any file attachment attached to this 
procedure when it was created in Procedure Entry. 

 

If you want to enter another procedure for the same supplier, then click on the right navigation button of the 
procedure window. 
 
Click the Exit button (or double-click the procedure window’s Control Menu icon) when you are through entering 
procedures, and you will be returned back to the underlying Supplier Entry form. 

Supplier Alarms 
There are two kinds of supplier alarms that can be set up. The first kind is a skip-lot alarm that will be triggered 
after you receive a user-defined number of shipments (lots). The second kind of alarm is calendar-based and 
will be triggered when you enter a receiving record for the supplier on or beyond a user-specified date. 
 
Alarms are triggered in the Received Material Entry form. Whenever an alarm is triggered, the user has the 
option of resetting the alarm (click the Clear button) or postponing the alarm (click the Snooze button). If the 
alarm is postponed, it will continue to be triggered with each shipment from the supplier until you reset it.  
Choosing the Reset button, will reset the count to zero. 

Note: As with procedures, if you are entering a new supplier record, make sure that you first save the 
supplier record (i.e., click on the record selector bar on the left side of the form or do a PAGE DOWN/PAGE 
UP sequence on the keyboard) before attempting to enter an alarm record.  
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To enter supplier alarms, click on the Alarms tab, and the Supplier Master Alarm Entry sub form will appear. 

 

Skip Lot/Rejection Alarm  
The supplier counter alarm fields are explained below:  
Field/Button Name Description 
Skip Lot Alarm  This is the point at which the counter alarm is triggered. When the value entered here is 

reached, the alarm is displayed. If this is set to an extremely high value (i.e., a value that 
will never be reached), then the alarm will not be triggered. When you click the Clear 
button, this field is set to 2,000,000,000 (two billion) - a value that for all practical purposes, 
will never be reached. When this field is set to 2,000,000,000, or blank the counter alarm is 
turned off.  

Current Shipment 
Count  

This is the current count of shipments (lots) received since the alarm was last reset. This is 
set to 0 (zero) when you click the Clear button. 

 
 

Supplier Calendar Date Alarm 
The supplier calendar alarm fields are explained below:  
Field/Button Name Description 
Calendar Alarm Date  
 

The calendar alarm will be triggered on this date. If a receiving record for the supplier is 
entered on or beyond this date, the alarm will be displayed. If this field is blank or set to a 
date far into the future (such as the year 2100), then the alarm will not be activated.  

Alarm Date Message This is the message that will be displayed when the calendar alarm is triggered. This is 
set to blank when you click the Clear button. Remember that you must press CTRL-
ENTER to insert new lines into memo fields.  

The Supplier Calendar Date Alarm is triggered when the user receives material on or after the date entered 
from the Receiving screen. Under QS-9000 rules, a supplier does not normally need to have shipments 
inspected. However, if a rejection is made, they are to inspect the Supplier’s next five shipments.  
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When you have completed the entry of the Alarms for the supplier, click on the Close button to save your alarm 
settings and return to the underlying Supplier Entry form. 



 

79 

Chapter 4: 
Supplier Part Entry 
Supplier Part Records 

Use Supplier Part records to store information about your supplier parts (and materials). You must set up your 
Supplier Part records before you can enter them in the receiving records. In the receiving records, you can 
select both the supplier and supplier parts from list boxes (to save time from manually typing them and to avoid 
data entry errors).  
 
The program does allow for part numbers to be duplicated between suppliers; however, they cannot be 
duplicated for the same supplier. In other words, two suppliers can share the same part number, but you 
cannot repeat the same part number for the same supplier. 
 
You can enter part records either from the Supplier Master Entry form (described earlier), or from the Supplier 
Part Entry form (discussed next). 
 
To enter part records, select Supplier Part Entry from the Enter/View Records menu. In the filter window, enter 
any search fields (just click the Find button if you are entering new records).  

 

The record entry form will appear, showing the first record. Click the New button on the navigation panel to add 
a new record. If you are looking for a certain record, use the navigation buttons to scroll through the records, or 
use either the Find or Edit Filter/Sort options in Record menu. 
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Supplier Part Record Fields 
The following fields are used in the supplier part record:  
Field/Button Name Description 
Supplier Code  The supplier code from the supplier master record. Click on the list box arrow to choose 

from available suppliers. 
Supplier Name  The program looks up and displays the supplier name after you enter the supplier code for 

the part. 
Supplier Part No. The number that the supplier uses to identify the part or material. As described earlier, this 

number can be duplicated for different suppliers. 
Company Part No. The number that your company uses internally to identify the part or material. This number 

also can be duplicated for different suppliers. 
Description The description that your company uses internally to identify the part or material. This 

description also can be duplicated for different suppliers. 
Unit of Meas. The unit of measure in which you track the part (such as each, pounds, feet, or gallons). 

This field creates a self-building, drop-down list box that will display all previously entered 
information to save typing time and avoid data entry errors. 

Unit Cost The unit cost of the part (rounds to nearest penny). 
Currency The currency symbol associated with this supplier part. 
Drawing No. The drawing number of the part (this field can be used for other purposes). 
Drawing Date The Drawing revision date associated with this supplier part. 

The historical drawing revision information is stored in the Receiving table for each 
receiving record throughout a part’s receiving history. 

Change Level The engineering change level of the part (this field can be used for other purposes). 
Change Date  The Change revision date associated with this supplier part. 

The historical change revision information is also stored in the Receiving table for each 
receiving record throughout a part’s receiving history. 

Last Received Date The last date on which this part was received from the supplier. The program automatically 
maintains this date every time a receiving record is created for the part. 

Sampling Plan  The sampling plan used when inspecting this part. This field is automatically copied from 
the part record to the receiving record when you enter receiving records for the part. 

User Defined 1 and 
User Defined 2  

These fields have been added to allow you to keep track of additional information about your 
parts.  
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Inspection Characteristics Table 
Located at the bottom of the form is an embedded table of inspection characteristics. You can set up a list of as 
many items as needed to check for when receiving the part. Each characteristic has the following fields:  
Characteristic The name of the characteristic being checked, such as width or viscosity. This list is maintained 

alphabetically (not in the order in which you originally entered them). If you want to control the 
order, then you should prefix each entry with a number and period, such as 1. Width, 2. Height, 3. 
Length. 

Value V is usually used for Variable numeric data; A is usually reserved for Attribute (visual inspection 
etc.) data. 

Minimum The minimum acceptable value of the characteristic (lower specification limit).  
Nominal  The nominal value for the characteristic (target or best value).  
Maximum The maximum acceptable value of the characteristic (upper specification limit). 

Supplier Part Procedures 
If needed, you can set up receiving inspection procedures for parts and materials. These procedures can be 
shared with many other parts or can be specific to one part. For example, you may have special tests that must 
be done only on a certain part from a certain supplier (part-specific procedures). On the other hand, you may 
have checks that must be done on incoming materials from a certain type of part or material coming from a 
variety of suppliers (shared procedures). 

Note: If you are entering a new part record, then make sure that you first save the part record (i.e., click on 
the record selector bar on the left side of the form or do a PAGE DOWN/PAGE UP sequence on the keyboard) 
before attempting to enter a part procedure record. Failure to do so will result in the error message “Can’t 
Have Null Value in Index” when you try to enter the procedure. 

To select part procedures, click on the Procedures tab, and a procedure entry sub form will appear. Select the 
procedure name and then the text of the procedure will appear below. If you want to use a procedure that you 
entered previously on another part, then use the same procedure name. 

 
On the Procedures OLE tab of this window is the OLE Box field. “OLE” stands for Object Linking and 

Embedding. This means that you can view any linked valid Windows object (such as a graph, picture, or digitized 
movie) that has been entered into this field when the procedure was created in procedure Entry.  

 
Also in this sub form is the Attachments tab. This allows you to view any file attachment attached to this 
procedure when it was created in Procedure Entry. 
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Click the Exit button when you are through entering procedures, and you will be returned back to the underlying 
Supplier Part record entry form. 

Part Alarms 
As with supplier alarms, there are Two kinds of part alarms that can be set up. The first kind is a skip-lot alarm 
that will be triggered after you receive a user-defined number of shipments (lots) of a part. The second kind of 
alarm is calendar-based and will be triggered when you enter a receiving record for the part that is on or 
beyond a user-specified date. 
 
To enter part alarms, click on the Alarms tab of Supplier Parts, and the Alarm Entry sub form will appear.  

 
Alarms are triggered in the Receiving Entry form. Whenever an alarm is triggered, you can reset the alarm 
(click the Clear button) or postpone the alarm (click the Snooze button). If the alarm is postponed, it will 
continue to be triggered with each shipment from the supplier until you reset it. The example provided above 
shows a supplier part for which the default of no realistic alarms will ever be reached (20000000 receiving 
records?, or a date beyond the year 2100?), thereby sequestering the alarm capabilities of the software for this 
supplier part. 

 
Note: As with procedures, if you are entering a new part record, then make sure that you first save the part 
record (i.e., click on the record selector bar on the left side of the form or do a PAGE DOWN/PAGE UP 
sequence on the keyboard) before attempting to enter an alarm record. Failure to do so will result in the 
error message “Can’t Have Null Value in Index” when you’re trying to enter the alarm. 

Part Counter Alarm 
The part counter alarm fields are explained below:  
Field/Button Name Description 
Skip Lot Alarm  This is the point at which the counter alarm is triggered. When the value entered here is 

reached, the alarm is displayed. If this is set to an extremely high value (i.e., a value that will 
never be reached), then the alarm will not be triggered. When you click the Clear button, this 
field is set to 2,000,000,000 (two billion) - a value that for all practical purposes, will never be 
reached. When this field is set to 2,000,000,000, or blank the counter alarm is turned off.  

Current Shipment 
Count 

This is the current count of shipments (lots) received since the alarm was last reset. This is 
set to 0 (zero) when you click the Clear button. 
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Example of Part Rejection Alarm when triggered:  

 

Part Calendar Alarm 
The part calendar alarm fields are explained below:  

Field/Button Name Description 
Calendar Alarm Date The calendar alarm will be triggered at this date. If a receiving record for the part is entered 

on or beyond this date, the alarm will be displayed. If this field is blank or set to a date far 
into the future (such as the year 2100), then the alarm will not be activated.  

Alarm Date Message This is the message that will be displayed when the calendar alarm is triggered. This is set to 
blank when you click the Clear button is clicked. Remember that you must press CTRL-
ENTER to insert new lines into memo fields. 

Example of Part Calendar Alarm when triggered: 

 

When you have completed the entry of the Alarms for the part, click on the Close button to save your alarm 
settings and return to the underlying Supplier Parts Entry form. 

 

Part Entry Attachments 
The Attachments tab of Supplier Part Entry is similar to procedure and supplier attachments. The files used for 
attachments can be of any file type that is supported on user’s workstations and registered in the Windows 
Registry. For example, if a CAD file is attached, and a user of SUPPLIERtrak does not have CAD software 
installed on their workstation, the file will not be able to be viewed or printed from that workstation. 
Files used in Part or any other attachment area in the software should reside on a common network drive, with 
common drive mappings between the range of SUPPLIERtrak users. Case in point, the example above. 
If the attachment is C:\Drawings\Part001.drg on one user’s pc and it is attached in SUPPLIERtrak, then another 
user of SUPPLIERtrak will not be able to see it due to it is not at C:\Drawings on their workstation. 
If the File is on G:\Products\Specifications\Part001.drg, and is attached in SUPPLIERtrak, then if at another 
user’s workstation the same folder is mapped differently, say M:\Specifications\Part001.drg, they will not be 
able to view the attachment as it is stored in the database due to the fact that this second user has his Drive M 
mapped to the first (attaching) user’s G:\Products directory on the network file server. 
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Part Entry Receiving History 
The Receiving History tab shows a form with the complete receiving history with rejection records for this 
supplier part. The example screenshot below shows a part that has been received once that just happens to 
have a single rejection record associated with that receiving record. 
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Clone Part Feature 
Part cloning allows you to create additional identical parts that have a different part number or to create exactly 
the same part for a different supplier. 
 
After you have entered all of the information for the part to be cloned, click the Clone Part button on the lower 
right corner of the Supplier Parts entry screen. 

 

 
  

Field/Button Name Description 

New Supplier Code Enter the supplier code for the new part, or select it from the list. 

New Part No. Enter the part number for the new part.   
 

Next, click the Clone button. All of the information that was entered for the original part will be copied to the 
part record for the cloned part, including Part Characteristics, Part Alarms, and Procedures. If you have several 
similar or identical parts, you can use Clone Part as many times as necessary. 
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Chapter 5: Received 
Material Entry 
Received Material Records 

Use the Received Material records (receiving records) to track and log all incoming parts and materials. The 
program automatically assigns a receiving log number to each record. This number is incremented by a value of 
one each time a new record is added. To save time, the program automatically enters the current date into both 
the Received Date and Due Date fields as well as the name of the current user into the Inspected By field.  
 
To enter receiving records, select Received Material Entry from the Enter/View Records menu. Next, enter any 
search fields (just click the Find button to see all un-archived receiving records or insert a 0 (zero) in the 
Receiving Log No field to enter a new record).  

 

 
The record entry form will appear, showing either a new record or the first record. Click the New button on the 
navigation panel to add a new record after reviewing existing records. If you are looking for a certain record, use 
the navigation buttons to scroll through the records or use either the Find or Edit Filter/Sort options in the 
Record menu. 
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Received Material Record Fields 
The following fields are used in the received material record: 

  
Field/Button Name Description 
Receiving Log No. The receiving log number is used to uniquely identify each receiving record. The value is 

incremented by one each time a new record is added. This field will display “(Counter)” until 
a supplier code and part number have been entered. This log number is used to relate the 
receiving record to both inspection measurement records and rejection records (if entered). 
This field cannot be edited. 

Supplier Code  Enter the supplier code or use the list box to select a supplier code. Entry required. 
Supplier Part No Click on the list box button to choose from the available list of part records for the supplier 

code that was chosen. Note: if you enter a part number that does not yet exist for this 
supplier, you can add it from this screen. 

Fields In Gray Company Part No, Description, Drawing No, Change Level, Sampling Plan and Unit of 
Measure are all related to the part information at the time of creation of this particular 
receiving record and are un-editable. 
Fields in Gray that are un-editable by the user because they are calculated solely by the 
software are the Lead Time, Days Early or Late, Quantity Rejected and Quantity Accepted 
fields. Quantity Rejected is updated by creating rejection records on the Rejects tab of the 
Received Material entry form, and is the sum of all Quantity Rejected from the associated 
rejection records. Quantity Accepted is calculated as Quantity Received minus total Quantity 
Rejected for each particular receiving record. 

Receive Date The receive date of this receiving record, When a new record is created, the default date is 
always today. 

Quantity Received The quantity received of this supplier part that relates to this receiving record. 
Quantity Inspected The quantity inspected of this supplier part that relates to this receiving record. Usually, 

this number is dictated by the sampling plan that is chosen for this supplier part. 
Received By The person receiving this shipment(s). 
Inspected By This is a general field for the receiving record. The Inspection records for each part 

selected of the Quantity Inspected can each have their own Inspected by code, indicating 
possibly different inspectors, and different times of inspection 

Rejection Code This is also a general field for the receiving record. The Rejection records for each part 
selected of the Quantity Rejected can each have their own Rejection code, indicating 
possibly different rejection reasons, and different times of rejection 

User Defined 1 and 2 User defined fields that relate to this receiving record. 
Shipper Number Used to document the Shipper if fulfillment is used and FOB, for example. 
Lot No Tracks the assigned Lot number of this shipment of this supplier part. This receiving record 

may be only a portion of the total number ordered, or may contain items backordered from 
an earlier order. 
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Field/Button Name Description 
Carrier Used to document the Carrier of the shipment that relates to this receiving record. 
PO Number Purchase Order number of shipment / lot received. 
Order date Manually entered. The order date of this material. The difference between the Order Date 

and the Receive Date is used to calculate the Lead Time. There are no skip Days / Dates 
associated in the software for the calculation of Lead Time because it depends on shippers 
and suppliers and elements outside of the scope of the software. 

Due Date Manually entered. The expected due date of the arrival of this material. The difference 
between the due date and the receive date (minus the grace periods selected in Setup – 
Settings) is used to calculate early or Late. 

Comments Enter any comments. Remember to press CTRL-ENTER to insert new lines of text into the 
Comments field. 

 

Receiving and Reject records imported from earlier versions of SUPPLIERtrak: 
When viewing a historical receiving record imported from a previous version, a separate control will 
show to the right of the field for Quantity Rejected on the main Received Material Entry form. If there 
is no reject record associated with the imported receiving record, the second control will be blank. 
The Quantity Rejected field will show as White to indicate a discrepancy between the main receiving 
record and the sum (tally) of Quantity Rejected from all related Reject Records, and will be editable if 
there is no data in the Quantity Rejected field for this receiving record. 
 

 
 
If there is a value in the receiving record for Quantity Rejected, but no associated reject record, the 
Quantity Rejected field is flagged in Yellow to signify the discrepancy. You can choose to enter a 
reject record associated with this receiving record at any time to coordinate the Quantity Rejected to 
a tally of all reject records individual Quantities Rejected if the historical data is still available to you. 
 

 
 
If there is a value in the receiving record for Quantity Rejected and there is an associated reject 
record, it should be the same as the value in the main Quantity Rejected and then both controls will 
show as gray and will be not be editable. 
 

 
 
If you should choose to add / modify any reject records associated with any historical (imported from 
previous versions) receiving record, and there is a discrepancy between the Tally of the individual 
reject records and the Quantity Rejected on the main form, the Quantity Rejected field will display  as 
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Yellow and will allow editing. The second control to the right, the tally, will always be gray and not 
editable by the user. 
 

 

 

Viewing Receiving History 
To view the complete history of receiving records for the part or material, click on the View History button. A 
pop-up window will appear, as shown here (click the Close button when you’re finished viewing the history):  
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Viewing Supplier Rating History 
To view the complete history of rating records for the supplier of this part or material, click on the small ellipsis 
button to the right of the Supplier Code selected for this receiving record. A pop-up window will appear, as 
shown here (click the Close button when you’re finished viewing the history): 

 

 

Inspection Forms 
To print an inspection form, click on the Insp. Form button. This form is useful for data collection purposes. It 
will include important information describing the part as well as a list of characteristics to inspect. An area for 
recording your results is provided.   

 



 Chapter 5: Received Material Entry 

 

92 

Viewing Procedures 
To view either supplier or part procedures, click on the corresponding tab—either the Supplier Procedures tab 
or the Part Procedures tab. There are two buttons that allow you to print or view the procedure.  
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The display report has the same appearance as the procedure report.  

 

Entering Inspection Results 
To enter inspection results, click on the Inspect Material  tab, and the parts inspection sub form will appear. This 
form consists of a top header portion and an imbedded table of inspection characteristics at the bottom for 
entering measurements. 

 
Each form represents the inspections on a single part. The entry fields are as follows: 

Inspection Results Header  
Field/Button Name Description 
Lot No This will default to the information that’s entered on the underlying receiving record form. It is 

used in the event that each sample part comes from different lots. This field can also be used to 
track other information as well; however, you must not leave it blank. 

Part ID This field will automatically number starting at 1 and continue up to the number of parts 
inspected. It can be manually overridden with user data, usually dictated by the sampling plan 
associated to this supplier part. 

Inspected By Select who is performing the inspection on this part this inspection date. 
Inspected By Name Grayed out – Filled in by the software program after an employee code (from the Staff Table) is 

selected in the Inspected By field. 
Inspection Date Enter the date of this part’s inspection. 
Accepted This field is used to track whether or not the part has been accepted. 
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Inspection Measurement Table 
To enter the list of pre-defined inspection characteristics, click on the button called Insert Characteristics List. 
Of course this works only if you set up a list of characteristics in the supplier part records. Otherwise, you will 
have to manually enter the characteristic names, minimums, nominals and maximums. 
 
The table fields are as follows:  
Field/Button Name Description 
Characteristic The name of the characteristic being measured, such as width or Viscosity. This list is 

maintained alphabetically (not in the order in which you enter each item). If you want to 
control the order, then you should prefix each entry with a number and period such as 1. 
Width, 2. Height, 3. Length. 

Type The type of characteristic where V=Variable and A=Attribute (pass/fail).  
Minimum  The minimum acceptable value of the characteristic (lower specification limit).  
Nominal The nominal value for the characteristic (target or best value).  
Maximum The maximum acceptable value of the characteristic (upper specification limit). 
Value The actual measured value of the characteristic or text, such as PASS or FAIL. 

 
Click on the navigation panel’s New button to add another inspection record for another part. Click on the 
navigation panel’s Close button to save your entries and return back to the underlying receiving record. 

Entering Rejection Records 
To enter rejection records, click the Reject Material tab, and the rejection entry sub form will appear.  

 
Note: You can enter multiple rejection records for a single receiving record, the reject ion codes and reasons 
for rejections can vary for any given receiving log entry. Each rejection record by default will have the 
default Corrective Action statement from the Setup > Settings > General tab, but each reject record can have 
this Statement changed to any other Corrective Action statement entered from Corrective Action statement 
entry also in the setup area of the software. 

 

AlsoNote: Previous versions of SUPPLIERtrak had no facility for entering the number rejected for any 
reason on the rejected materials form.  Version 4.6 calculates the total Quantity Rejected from each 
rejection record entered for any given receiving record and tallies this result on the main Received Material 
Entry form. To allow for this difference between versions, please see the above breakdown of how version 
4.6 allows users to review and update any discrepancies between the Quantity Rejected on the Received 
Material Entry form with reject records imported from previous versions by running the Data Transfer 
Utility. Please refer to the Data Transfer Utility section in the Appendix on page 166 for how the Data 
Transfer Utility populates the Quantity Rejected field in the Rejects table from the Quantity Rejected field in 
the Receiving table when transferring data from previous versions. 
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Rejection Record Fields  
Field/Button Name Description 
Reject No.  As with receiving log numbers, this field increments by one each time a rejection record is 

added - it will say “0” until you save the record. This allows each rejection to be automatically 
uniquely identified. 

Reject Date The date that the rejection was issued. It is automatically set to the current date. 
Reject Type This field is used for tracking the type of rejection (such as warning or return for credit). You 

should create a code system for identifying the types of rejections that your company normally 
issues.  
The Reject Type Description will appear to the right of the Reject Type code after selecting 
from the drop down list. 

Disp Code Enter a code indicating the disposition of the material (open, closed, return to supplier, scrap, 
or rework).  
The Disposition code Description will appear to the right of the Disposition code after selecting 
from the drop down list. 

Reject Code Select a Reject code indicating the  reject type that pertains to this rejection record, this will 
usually be dependent on the sampling plan that relates to this supplier part. 
The Reject Code Description will appear to the right of the Reject code after selecting from the 
drop down list. 

Auth Date The date on which the supplier authorized the disposition. 
Auth No Authorization number issued by the supplier (if applicable). 
Auth. By The name of the person at the supplier company that authorized the disposition. Information 

entered into this field creates a self-building list.  
Qty Rejected The quantity rejected from this shipment due to this reason (Corrective Action, Disposition) 
Qty Returned The quantity of material being returned. 
Qty Scrapped The quantity of material being scrapped or discarded. 
Qty Reworked The quantity of material being reworked or repaired. 
Rejection Cost Fields These fields reflect the breakdown of the costs being charged back to the supplier for the 

reason s specified for this rejection record. 
Currency The default currency symbol is taken from the Supplier Part record for this supplier part. It 

can be edited for each rejection record separately without changing the default entry in 
Supplier Part Entry. 

User Defined 1 and 2 User defined fields that relate to this rejection record. 
Closed Click this radio button to indicate that the rejection notice is closed. 
C A Date The date the Corrective Action Letter was Created and Corrective Action response tracking 

begins 
Close Date The date the Corrective Action is responded to and closed by the Supplier.  
Response I n Days This is calculated by the software. It is the response time difference between the CA Date and 

the Close date in Days.  There are no skip Days / Dates associated in the software for the 
calculation of Response time because it depends on suppliers and elements outside of the 
scope of the software. 

Comments Enter any comments. Remember to press CTRL-ENTER to insert new lines of text into the 
Comments field. 

Rejection Alarm  
The way this alarm feature works, you can set it up so that on the fifth shipment following the rejection, the 
alarm will ask if you need to inspect the next five shipments. By pressing the Yes button, you have accepted the 
alarm, and on the sixth shipment you will be reminded to inspect it.  
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Rejection Notices 
To print a rejection notice for the supplier, click on the Print Rejection Notice button in this screen. After the 
print dialog window appears, click on the checkboxes for either including or excluding the inspection results and 
corrective action statement along with the rejection notice form. If you need to print a batch of rejection notices 
for a number of different suppliers, you can choose Reject Notice from the Listings and Reports submenu in the 
main menu. You can preview rejection notices on-screen before you print them. 

 

Example of Reject Notice: 

 

Accept and Reject Tags 
You can print both Accept and Reject tags for identifying incoming materials that have been inspected. Tags are 
designed so that they print one per page (regardless of page size). Since you have complete control over the 
orientation, paper size, and margins, you can, in most cases, use standard off-the-shelf label stock or card 
stock. Before actually printing, you may want to view label on-screen and then experiment with the Print Setup 
settings before actually printing (go to the File menu and select Print Setup). If you need customized tags, please 
contact Technical Support for other options. 

 

Accept/Reject Tag Layouts 
There are several tag layouts to choose from, depending on the type of paper stock and printer that you want to 
use. These layouts are explained below: 

Laser—This is designed for use on stock that is ¼ the size of an 8½” x 11” sheet of paper (5½” W x 4¼” L). 
Remember to place your tag into the printer in landscape orientation. 
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Dot Matrix—This is designed for use on stock of 4” W x 3” L labels (pin feed roll or fanfold stock). First, you will 
have to set up a User Defined paper size in the Printers icon of the Windows Control Panel. The User Defined 
paper size must match your label’s exact top-to-top length dimension (width is not important). Also, make sure 
you enter the dimensions in 1/100ths of an inch (enter 3 inches as 300). 

 
Next, preview the label within SUPPLIERtrak and use File | Print Setup to set up the User Defined paper size for 
both the Accept and Reject tags. When you close the preview window, you will be able to save the printer 
settings to the program (this only needs to be done once, unless you re-install or update SUPPLIERtrak). 

 
Field/Button Name Description 
Standard  This layout is 1/3 page (6” W x 2½” L). Place your tag into the printer in the normal (portrait) 

orientation. 
Custom  This is used for custom-designed tags (contact CyberMetrics or your distributor for 

information on custom-designed tags). 

 

Printing Accept Tags 
To print Accepted Material tags, click on the Print Accept Tags button. Next, enter the quantity of tags to be 
printed. To preview tags on-screen before printing, click the View button.  

 

Printing Reject Tags 
To print Rejected Material tags, click on the Print Reject Tags button. Next, enter the quantity of tags to be 
printed. To preview tags on-screen before printing, click the View button. 
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Chapter 6:  
Procedure Entry 
Procedure Entry 

In Procedure Entry, you can enter and view detailed procedure records for use with both Suppliers and Parts, 
including pictures and attachment records to files stored in a common area on a network drive. 

Procedure Entry—Procedure Text 
In this screen, you can copy or enter the text of each procedure.  If Maintain Receiving Procedure History is set 
to true (checked), then the text of a specific procedure can be edited until it is used in a receiving record.  Once it 
has been used in an historical receiving record, the procedure is locked down so no changes can be made to it, 
and it cannot be deleted. If Maintain Receiving Procedure History is set to false (unchecked), then edits can be 
made any time even if the procedure is used in a receiving record, and you can delete the procedure as well.  To 
learn more about the Maintain Receiving Procedure History control see section “Settings – General” of Chapter 
12 on page 137. 

 
The following table explains each of the fields and buttons in this screen:    

Field Name Description 

Procedure Name Enter a unique title for each procedure. If you try to create two procedures with the same 
name, GAGEtrak prompts you that you can’t have duplicate index values. If this happens, 
enter a unique procedure name or click Undo. 

Procedure In this field, enter the text of the procedure. You can copy and paste from another textual 
format document. 

Current Check this box to show that this procedure is currently active. If you don’t mark the 
procedure as active, it will not be available for future attachment to either Parts Or Suppliers. 

New To create a new record. This button will create a new record for the entering of a new 
procedure. 
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Field Name Description 

Undo This button is only enabled when a procedure is not used for any historical receiving records 
and also the checkmark for Maintain Receiving Procedure History in Settings is checked. 
This will undo any changes made by the user after the record was last saved / created. 

Delete This button is only enabled when a procedure is not used for any historical receiving records 
and also the checkmark for Maintain Receiving Procedure History in Settings is checked. 
This will Delete the current procedure if the user has rights to delete Procedures if Security 
is enabled. The procedure will be deleted from all supporting tables as well. 

Remove This button will not delete the current procedure; just remove its reference to any Parts Or 
Suppliers it is currently linked to. This will not undo historical receiving records, but will 
affect future receiving records after removal. 

Clone This Button will clone a procedure and allow you to create a new procedure from the original 
without re-creating it from scratch. Useful if a procedure has been used historically and it is 
deemed necessary to update the procedures followed to current standards. Give the cloned 
new procedure the new revision code / date as part of the new unique Procedure Name. 

Exit Close the Procedure Entry Form. 

 

Procedure Entry—Procedure Image 
In the Procedure Image screen, you can attach a picture or map to each procedure. To do so, double-click in the 
OLE box. 

 
“OLE” stands for “Object Linking and Embedding”. This means that you can link any valid Windows object (such 
as a graph, picture, or digitized movie) into this field. When you double-click in the OLE field, the Insert Object 
box appears, and you can select the program in which you created (or will create) the object. 

Note: The list of object types varies, depending on which programs are on your computer. 

 
Use the scroll bar to select the type of object you want associated with the procedure, and then click OK. When 
you select an object type, the program in which you created the object opens so that you can edit the image (if 
necessary). When you’re finished, just click inside the OLE object box which links the object to the associated 
procedure, this returns you to Procedure Image. 
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Procedure Entry—Procedure Attachments 
In the Procedure Attachments screen, you can attach additional information related to the specific procedure 
name, for example an amendment to the existing procedure explaining revised processes. 

 
Use the File—Control for the selected record to view the attachment if the path is the same at your local client 
PC and also if you have the associated application installed on your PC. Although the example shown above 
shows paths to files on a local C:\ drive, it is advisable to have all procedure attachments on a network drive that 
is mapped similarly from all clients expected to run the SUPPLIERtrak application. 
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Chapter 7:  
Staff Entry 
Staff Entry 

In Staff Entry, you can enter and view detailed employee records for your staff, including information like 
training, ID photo, what gages their authorized to use, and whether a gage has been issued to them. 

Staff Entry—Information 

 
The following table explains each of the fields and buttons in this screen:    

Field Name Description 

Employee ID Enter a unique alphanumeric identifier for each employee. 

Name In this field, enter the employee’s full name. 

Active Check this box to show that the employee is currently active. If you don’t mark the employee 
as active, his or her name won’t appear on reports that list available employees. 

Address, City, State, and Zip Enter the employee’s mailing address, including city, state, and zip code. 

E-Mail Enter the employee’s e-mail address. 

Home/Pager and 
Work Phone/Ext. 

Enter the employee’s home phone number, pager number, work number and extension. 

Emergency Contact Name 
and Phone 

Enter a person’s name and phone number to contact in case of emergency. 

Craft Use this field to categorize your workers by profession. You can use a description, such as 
welder or electrical engineer; a code, like MIG-3; or a union number combined with a 
classification, such as 786-Journeyman or 786-Apprentice. 

Rate Enter the employee’s hourly rate.  
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Field Name Description 

Seniority Enter the seniority or other work status of the employee. You could use this field to store the 
date that determines seniority. 

Skill Level Using either an internal or external classification system, assign a skill level to each 
employee. You could also use this field to indicate multiple skills for your employees, 
assigning letters or numbers for different skills.  

SS No. Enter the employee’s social security number. 

Job Title Enter the employee’s official job title. 

DOB Employee’s date of birth. 

Date Hired and 
Date in Job 

Enter the date(s) in which you hired the employee and when the employee started his or her 
current position. 

Department Enter the primary department the employee belongs to. 

Supervisor Enter the name of the employee’s direct supervisor. 

Shift Indicate the shift(s) for which this employee is available. 

Crew Use this field to track the name of the crew(s) to which this employee either belongs or is 
qualified to belong. 

Staff User 1 and  
Staff User 2 

Use these two fields to store any additional employee related information.  

Staff Entry—Training 

 
Use the Staff Entry—Training screen to keep track of the employee’s current and continuing education. The 
table below describes the fields in this screen:   

Field Name Description 

Education Give a basic description of the employee’s education, for example: BS – Mechanical Engineering. 

Industry Experience Enter the employee’s work experience, for example: 6 years Inspection Technician, Grade II. 

Related Experience Use this field to track any other useful experience, such as AutoCAD 3-dimensional wire 
diagramming. 

Management 
Experience 

Enter any management experience that the employee has–for example, Supervised Inspection Dept. 
in 2000. 
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Training History 
In this section, you can track classes or certifications that each employee has completed. Use the scroll bar at 
the bottom of the screen to see the different fields.   

Field Name Description 

Description Enter a brief description of the training. 

Start Date and 
End Date 

Beginning and ending dates of the training. 

School Enter the name of the school where the employee attended training. 

Cost Enter the cost of the class. 

Status Use this field to indicate whether the employee has finished this particular class. 

Certification If this training was for a particular certification, enter the type of certificate. 

Cert. Expiration Date If the certification is good for only a specified length of time, enter the expiration date in this field. 

Hours Enter how many hours the training was worth or how long it lasted. 

CEUs (Continuing 
Education Units) 

In this field, enter the number of credit units earned for the training.  

Comments Enter any other relevant information for this training or certification. 

Staff Entry—Photo 

 
Click this tab to attach a personnel photo; for more information, see Insert Object and Paste Logo In Settings – 
LOGO section for more information. 
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Chapter 8:  
Ratings Entry 
Rating Records 

Use the Supplier Rating records to track the rating results on your suppliers. If needed, the program allows you 
to define one or more rating setups (you may want one setup for parts suppliers and another setup for service 
suppliers). Each rating setup is identified by a unique rating code (most companies will use only one rating 
setup, in which all their suppliers are subjected to the same rating guidelines). 

Defining Rating Setups 
You can define a very simple rating setup that has just a few criteria, or a more elaborate setup with multiple 
sections and multiple criteria. SUPPLIERtrak also allows you to define the rating formula. Rating formulas may 
consist of just a simple total of all rating criteria scores, or a more complex scheme with tallied rating section 
criteria and a weighted average of each section for the overall score.  
 
Before you can enter rating records, you must first define the rating setup. This is done by selecting Ratings 
Definition from the Tools & Utilities menu. After the search window appears, click on the Find button. As an 
example of a very simple rating definition, suppose that you wanted to create a rating setup that would end up 
looking like this:  

RATING 
RATING CRITERIA SCORE 
1. Quality 90 
2. Delivery 95 
3. Price 90 
4. Service 92 
Overall Score (Average) 91.7  

Steps to create this rating definition: 

1. Select Ratings Definition from the main menu Tools & Utilities submenu. 
2. After the search window appears, click on the Find button. 
3. After the Rating Definition form appears, enter the following:  

Field/Button Name Description 
Rating Code Enter R1 (this is the how the system identifies a definition setup) 
Category  Enter 01 (this is the first and only category for this setup). 
Formula  Enter [01]+[02]+[03]+[04] (the numbers in square brackets correspond to the criteria numbers 

(i.e., there are four criteria and these need to be totaled at first). 
Criteria Table  This table holds the criteria numbers and their corresponding descriptions. Set these up as 

follows: 
Criteria  Descriptions* 
01 01.                            Quality 
02 02.                           Delivery 
03 03.                           Price 
0404.                           Service 
*Note that each description starts with a number and period. This is done to control the sort 

order. Without the numbers, the sort order would be “Delivery, Price, Quality, Service” 
(alphabetically sorted) on your reports. 
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Your rating definition form should look like the one shown below: 

 
4. Next, click the New button on the navigation panel. Now the overall formula will be added. Set this 

form up as follows:  
Field/Button Name Description 
Rating Code Enter R1 (use the same code to link the two rating category records). 
Category  Enter 99 (this tells the system that this is an overall score category for this rating setup; 

remember, each rating definition can have only one overall category of 99). 
Category Description Enter Rating as your Category Description. 
Formula  Enter [01] / 4 to have the overall score be an average (because this is a 99 category, the 

number in the square brackets represents the category numbers, not the criteria 
numbers). 

Criteria Table  Leave blank (not needed for overall score category).  
The rating definition form for the Overall category should look like the one below: 

 
Now that the rating setup has been defined, you can enter the supplier’s actual score results into the rating 
records. To do this, click on the Close button and return to the main menu.  

Note: You only have to set up the rating definitions once, unless you want to add more rating definitions, 
such as having one setup for your part and materials suppliers and another for your service suppliers. 
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Entering Rating Records 
The rating records are used to store your actual supplier rating results (scores). Select Ratings Entry from the 
Enter/View Records menu. 

 
Click the Find button after the Rating Search form appears, then click on the New button to create a new rating 
record. Here is an example of a Rating record created with the criteria entered in the Rating Definition. 

 
The rating entry fields are as follows:  

Field/Button 
Name 

Description 

Rating Log No This is a counter field that is automatically incremented by 1 with each new rating record. 
Rating Code Enter the rating code here (enter S1 to bring up the rating for the sample rating definition). You 

can also use the drop-down list box to select from available rating codes. 
Supplier Code Enter the supplier code of the supplier you are rating (use the drop-down list box to select from 

available suppliers). 
Supplier Name The name of the supplier will be looked up and displayed. 
Rating Date Enter the date of the rating (the current date will be inserted automatically). The date entered 

here is automatically posted to the Supplier Master record in the Last Rating date field. 
Rated By Enter the name of the person performing the rating (your name). This field creates a self-

building list displaying all unique entries. 
Comments Enter any comments (remember to press CTRL-ENTER to insert new lines into memo fields). 
Rating Score 
Table 

As soon as you click in the first column of this table, the list of rating category criteria will be 
inserted here. Enter the scores for each rating criterion into the last column, labeled “Scores”. 

Summary The summary table will be filled in with names of the categories defined for the rating. First, 
click the Update button to insert the categories. The category scores will be automatically 
calculated using the formulas you defined and will be displayed in the rightmost Scores column 
of this table. 

 
The completed rating record should look like the one shown above. 
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Chapter 9:  
Survey Entry 
Survey Records 

Use the Supplier Survey records to track the results of your on-site surveys. If needed, the program allows you 
to define one or more survey setups (you may want one type of survey setup for parts and materials suppliers 
and another survey setup for your service suppliers). As with rating setups, each survey setup is identified by a 
unique code. The format of survey records is exactly like that of the rating records, except that the Criteria field 
is called a Question in the survey records. Rather than duplicate the information here, please see the prior 
section on Rating Records for instructions on setting up your survey definitions and on entering survey results.  
 
You can use the Rating/Survey Wizard to create a new rating or survey or to modify one that has previously been 
created using the Wizard. To enter a new rating or survey using the Wizard, choose Rating/Survey Wizard from 
the Tools and Utilities menu. 

Defining Survey Setups 
You can define a very simple survey setup that has just a few criteria, or a more elaborate setup with multiple 
sections and multiple criteria. SUPPLIERtrak also allows you to define the survey formula. Survey formulas may 
consist of just a simple total of all rating criteria scores, or a more complex scheme with tallied rating section 
criteria and a weighted average of each section for the overall score.  
 
Before you can enter survey records, you must first define the survey setup. This is done by selecting Survey 
Definition from the Tools & Utilities menu.  
 
Steps to create this rating definition: 

1. Select Survey Definition from the main menu Tools & Utilities submenu. 
2. After the search window appears, click on the Find button. 
3. After the Survey Definition form appears, enter the following: 

 
Field/Button Name Description 
Survey Code Enter S1 (this is the how the system identifies a definition setup) 
Category  Enter 1 (this is the first and only category for this setup). 
Category Description  Enter Delivery for the description. 
Formula  Enter: [01]+[02]+[03]+[04]+[05]+[06]+[07]+[08]+[09]+[10]+[11]+[12]+[13]+[14]+[15]+[16]+[17] 
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Field/Button Name Description 
Questions This table holds the criteria numbers and their corresponding descriptions. Set these up 

as follows: 
Criteria  Descriptions* 

01 Management Responsibility 
02 Quality System 
03 Contract Review 
04 Design Control 
05 Document and Data Control 
06 Purchasing 
07 Control of Customer-Supplied Product 
08 Product Identification and Traceability 
09 Process Control 
10 Inspection and Testing 
11 Control of Inspection, Measuring and Test Equipment 
12 Inspection and Test Status 
13 Control of Nonconforming Product  
14 Corrective and Preventive Action 
15 Handle, Store, Package, Preserve and Delivery 
16 Control of Quality Records 
17 Internal Quality Audits 

 Taken from the QS-9000 Requirements, August 1994.  

Example of this Survey Definition with formula: 

 
4. Next, click the New button on the navigation panel. Now the overall formula will be added. Set this 

form up as follows:  
Field/Button Name Description 
Survey Code Enter S1 (use the same code to link the two rating category records). 
Category  Enter 99 (this tells the system that this is an overall score category for this survey setup; 

remember, each survey definition can have only one overall category of 99). 
Category Description Enter Quality as your Category Description. 
Formula  Enter [01] /17 to have the overall score be an average (because this is a 99 category, the 

number in the square brackets represents the category numbers, not the criteria numbers). 
Criteria Table  Leave blank (not needed for overall score category). 

 



 SUPPLIERtrak™ User’s Manual 

 

113 

The survey definition form for the Overall category should look like the one below: 

 

Now that the survey setup has been defined, you can enter the supplier’s actual score results into the survey 
records. To do this, click on the Close button and return to the main menu.  

Note: You only have to set up the survey definitions once, unless you want to add more definitions, such as 
having one setup for your part and materials suppliers and another for your service suppliers. 

Entering Survey Records 
The rating records are used to store your actual supplier rating results (scores). Select Ratings Entry from the 
Enter/View Records menu. 
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The completed rating record should look like the one shown below: 

 
The fields for the Survey Entry screen are as follows:   
Field/Button Name Description 
Survey Log No. This is a counter field that is automatically incremented by 1 with each new survey record. 
Survey Code  Enter the survey code here (enter S1 to bring up the rating for the sample survey definition). 

You can also use the drop-down list box to select from available survey codes. 
Supplier Code Enter the supplier code of the supplier you are surveying (use the drop-down list box to select 

from available suppliers). 
Supplier Name The name of the supplier will be looked up and displayed. 
Survey Date Enter the date of the survey (the current date will be inserted automatically). The date 

entered here is automatically posted to the Supplier Master record in the Last Survey date 
field. 

Surveyed By Enter the name of the person performing the survey (your name). This field creates a self-
building list displaying all unique entries. 

Comments Enter any comments (remember to press CTRL-ENTER to insert new lines into memo fields). 
Questions These are the questions asked on the survey of the Supplier. The Questions field shows the 

question number it was on the survey. The Description of the question and the score is the 
percentage or other number representing the answer.  

Summary The summary table will be filled in with names of the categories defined for the survey. First, 
click the Update button to insert the categories. The category scores will be automatically 
calculated using the formulas you defined and will be displayed in the rightmost Scores 
column of this table. 

Update Click this button to Update the Summary fields.  
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Chapter 10:  
Listings and Reports 
Listings and Reports Menu 

SUPPLIERtrak includes a variety of standard reports. Most reports allow you to select the sort order by clicking 
on the appropriate sort button. You can also enter optional search filters for printing subsets of your records. 
Some reports are time-based (such as the Received Material Listing), and you can enter the date range of 
interest into the From Date and To Date filter fields. All reports have been designed using the standard 
Windows True Type fonts. The fonts used in the reports cannot be changed. 

 

 
Click on the main report types, to see the reports under each category. 

Print Setup 
Certain reports settings, such as orientation (portrait or landscape) and margins can be modified.  
Report settings can be modified by selecting Print Setup from the File menu. 
 
Some options are controlled by the type of printer and the Windows printer driver that you have, but a typical 
setup window looks like this: 
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Tip: To save paper and time, you may want to first view the report on-screen and then adjust the print setup 
values. You can immediately see any changes on-screen after you click the OK button. 

The program will ask you if you want to save the new settings when you close the report window. 

Output To 
The Output To command from the File menu allows the output of reports to a text file, Microsoft .RTF file, or 
Microsoft Excel spreadsheet file. For reports, output in .TXT or .RTF format includes the contents of text boxes 
as well as the text box labels. If you save a file in .RTF format and then open that file in a word processing 
application, such as Microsoft Word, your data appears in a formatted table. When you save the output in .XLS or 
.RTF format, it includes fonts, layout, and other formatting elements. 

 

 
When you choose the type of file you want to Output the report as, click Export button on the right. You should 
find the exported report file in the same location as your database. 
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Send 
The Send command from the File menu allows the output of reports to Microsoft Mail (or any MAPI compatible 
mail program). The output does not include sub forms and sub reports. When you save the output in .XLS or 
.RTF format, it includes fonts, layout, and other formatting elements. 

 
After you choose the format to Send the file in, it will open a new email message with the report as an 
attachment to the message.  

Viewing Reports 
You can preview all reports on-screen by clicking the View button. After the report appears, you can scroll 
through it in any direction by using the scroll bars. You can go to other pages by clicking on the navigation 
buttons in the lower left corner of the viewing window. To zoom in (or out of the report), click anywhere on the 
body of the report. Keyboard shortcuts are listed below: 

Print Preview Keyboard Shortcuts   
Press To 
P Print the report 
S Open the Setup dialog box 
Z Zoom in (or out) for a magnified view of part of the page 
C or ESC Cancel Print Preview  

To view different pages in Print Preview when zoomed-out:  
Press To 
F5 Move to the page number box; then type the page number you 

want to go to and press ENTER 
PAGE DOWN or DOWN ARROW Move to the next page (when zoomed out) 
END Move to the last page 
PAGE UP or UP ARROW Move to the previous page (when zoomed out) 
HOME Move to the first page  

To view different parts of the current page when zoomed-in:  
Press To 
DOWN ARROW Scroll down in small increments 
PAGE DOWN Scroll down in large increments 
CTRL DOWN ARROW Move to the bottom of the page 
UP ARROW Scroll up in small increments 
PAGE UP Scroll up in large increments 
CTRL+UP ARROW Move to the top of the page 
RIGHT ARROW Scroll to the right in small increments 
CTRL RIGHT ARROW or END Move to the right edge of the page 
CTRL+END Move to the lower-right corner of the page 
LEFT ARROW Scroll to the left in small increments 
CTRL+LEFT ARROW or HOME Move to the left edge of the page 
CTRL+HOME Move to the upper-left corner of the page 
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Supplier Performance Report 
The Supplier Performance report is a management summary report that tells you how well or how poorly 
suppliers have been performing. The report provides information on quantity rejections, lot rejections, and 
delivery for any given time frame. Typically, you will run this report on a monthly or quarterly basis. Received 
material that is later rejected is included in the report for same time period during which it was received. 
Received material can be inspected and rejected at any time and still be included in the performance 
calculations. 

 

Supplier Part Performance Report 
This report summarizes performance by part number for any given date range. The Supplier Part Performance 
report allows you to filter on both the supplier code (to generate for one supplier) and on the supplier part 
number (if you only want results on a single part number). Received material that is later rejected is included in 
the report for same time period during which it was received. Received material can be inspected and rejected 
at any time and still be included in the performance calculations. 
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Received Material Report 
The Received Material report is simply a listing of your received materials log. It can optionally include the 
inspection results along with each receiving record. 
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Rejected Material Report 
The Rejected Material report is simply a listing of your rejection records. It can optionally include the inspection 
results along with each rejection record. If you use a code, such as “Open”, in the rejection record’s disposition 
code, you can use this report to generate a list of open (meaning that the supplier hasn’t responded yet) 
rejections. Enter the word “Open” into the Disp Code filter field. 
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Rejection Notice Report 
This report is used to print a batch of rejection notices (you can also print the notice from within the rejection 
entry window, but only one at a time). You can run this report to print all of your rejection notices at the end of 
the day. This report allows you to optionally include the inspection results and the Corrective Action statement 
(used for requesting a written action plan from your suppliers - the text of this statement can be modified in the 
SUPPLIERtrak Settings screen). 
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Rejection Cost Report 
The Rejection Cost Report is a listing of your costs for each Supplier. It can display results for one Supplier by 
selecting from the drop down list, or for all suppliers by choosing Clear Fields. You can include a certain date 
range to be displayed and choose to sort by Supplier Code or by Supplier Name.  

 

Rating Report 
The Rating report is used to generate either a summary listing or forms of your rating records. Click the Print 
Form option box if you want one rating per page to be printed. 
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Rating Report (Current and Previous) 
This report allows you to print both the current and previous ratings on a supplier. The report also allows you to 
include a performance summary if needed. 
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Survey Report 
The Survey report is used to generate either a summary listing or forms of your survey records. Click the Print 
Form option box if you want one survey per page to be printed. 

 

Supplier Listing Report 
The Supplier Listing report is used to print a list of your supplier records. You have the option of including the 
list of supplier part records with each supplier record (the list of parts is printed below each supplier record).  
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Supplier Part Listing Report 
Use the Supplier Part Listing report to print a list of your part records. You have the option of including the 
inspection characteristics for each part record (the list of characteristics is printed below each part record). 

 

Supplier Procedure Cross Reference Listing 
Use this report to print a summary listing of your supplier procedures. Depending on how you sort it, you can 
use it to see which suppliers are sharing the same procedures. 
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Supplier Procedure Report 
Use the Supplier Procedure report to print a listing of your supplier procedures, including the body of text in the 
procedures. An option is available that allows you to print one procedure per page. 

 

Part Procedure Cross Reference Listing 
Use the Part Procedure Cross-Reference report to print a listing of your part procedures. Depending on how 
you sort it, you can use it to see which parts are sharing the same procedures. 

 

Part Procedure Report 
Use the Part Procedure report to print a listing of your part procedures, including the body of text in the 
procedures. An option is available that allows you to print one procedure per page. 
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Active Supplier Alarm Listing 
Use this report to print a listing of active supplier alarms. Only those supplier records that have an active 
counter or a calendar-based alarm will be printed. 

 

Active Part Alarm Listing 
Use this report is used to print a listing of active part alarms. Only those part records that have an active 
counter or a calendar-based alarm will be printed. 

 

Corrective Action Listing 
Use this report to print a listing of open corrective action notices. Only those rejection records that have a date 
in the Date C.A. Sent field, with the Closed radio button field not checked, will be printed. 
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Supplier Detail Report 
Use the Supplier Detail report to print a list of your supplier records. This report gives you all of the supplier 
master information on a single page printout per supplier.  
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Chapter 11:  
Graphs and Charts 
 

To generate charts, go to the main menu and select the Graphs and Charts menu. You can view, print, and send, 
all charts. As in the entry screens, each report starts with a filter window that allows you to define the subset of 
records that you wish to print.  
 
Each chart does include the option to enter the date range of interest into the From Date and To Date filter 
fields. All reports were designed using standard Windows True Type fonts. 

Viewing Charts 
After entering the filter criteria, click the Chart button, and the charted report appears. The charts can be 
viewed in any direction by using the scroll bars. You can go to other pages by clicking on the navigation buttons 
in the lower left corner of the viewing window. A magnifying class will replace your mouse cursor, this is to be 
used to zoom in (or out) of the chart by clicking anywhere on the body of the report. 

Print Preview Keyboard Shortcuts 
Print Preview keyboard shortcuts are listed below.  

Press To 
P Print the report (brings up the print dialog box) 
S Open the Setup dialog box 
Z Zoom in (or out) for a magnified view of part of the page 
C or ESC Cancel Print Preview 

 
To view different pages in Chart view when zoomed-out:  

Press To 
F5 Move to the page number box; then type the page number you want to go to 

and press ENTER 
PAGE DOWN or 
DOWN ARROW 

Move to the next page (when zoomed out) 

END Move to the last page 
PAGE UP or  
UP ARROW 

Move to the previous page (when zoomed out) 

HOME Move to the first page 

 
To view different parts of the current page using the zoomed-in feature in Print Preview:  

Press To 
DOWN ARROW Scroll down in small increments 
PAGE DOWN Scroll down in large increments 
CTRL DOWN ARROW Move to the bottom of the page 
UP ARROW Scroll up in small increments 
PAGE UP Scroll up in large increments 
CTRL+UP ARROW Move to the top of the page 
RIGHT ARROW Scroll to the right in small increments 
CTRL RIGHT ARROW or END Move to the right edge of the page 
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Press To 
CTRL+END Move to the lower-right corner of the page 
LEFT ARROW Scroll to the left in small increments 
CTRL+LEFT ARROW or HOME Move to the left edge of the page 
CTRL+HOME Move to the upper-left corner of the page 

Print Setup 
You can change certain reports settings, such as orientation (Portrait or Landscape) or margins, by selecting 
Print Setup from the File menu. 
 
Some options are controlled by the type of printer and the Windows printer driver that you have, but a typical 
setup window looks like this: 

 
Tip: To save paper and time, you can first view the report on-screen and then adjust the print setup values. 
You’ll immediately see any changes on-screen after you click the OK button. When you close the report 
window, the program will save the new settings. 

Output To 
The Output To command from the File menu allows you to output reports to a text file, Microsoft .RTF file, 
Microsoft Excel spreadsheet file, Snapshot file, HTML or Microsoft Database file. If you save a file in .RTF format 
and then open that file in a word processing application, such as Microsoft Word, your data appears in a 
formatted table. When you save the output in .XLS or .RTF format, it includes fonts, layout, and other formatting 
elements.  

Send 
The Send command from the File menu allows the output of reports to Microsoft Mail (or any MAPI compatible 
mail program). The output does not include sub forms and sub reports. When you save the output in .XLS or 
.RTF format, it includes fonts, layout, and other formatting elements.  
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Reports—Descriptions  
Worst Supplier Chart 

This report is based off the percent of the supplier lots rejected or by the percent of lots that are late. You can 
choose the top worst supplier or up to 20 of your worst suppliers. By adding a date range, you can get a time 
frame of when a supplier(s) may have performed better or worse. When choosing the Clear Filter button, this 
will erase the date fields and only include the Analysis Of and No. of Suppliers fields.  

 

 
In the example shown below, the charted report shows the top five Suppliers with the highest percent of lots 
rejected at present. Notice no date range was given. 

 

Parts Comparison Chart 
Use this chart to create a comparison of one company part number supplied by several suppliers. It will chart 
the percentage of rejection or the percent late, for those suppliers that supply the part. You must first select a 
part number from the drop down list, and then optionally place a date range.   
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In the example shown below, the part number of E-108-C, is shown to have a 42 percent rejection rate when 
supplied by supplier “Company A”. 

 

 

Supplier Performance Chart 

Grouped by Month, Week or Quarter, you can display an individual Supplier’s Performance.  

There will be four charts produced for this one Supplier Code, they are the Percent Rejected By (Week, Month, 
Quarter) Top 10 Rejection Reasons (with reject code), 10 Worst Part Numbers and Late Deliveries By (Week, 
Month, Quarter). You must choose a supplier code to produce a report.  
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Supplier Comparative Chart 
This chart will show the difference between one date range and another date range for a specific Supplier.  
 
This would be good for showing the improvements or failure rates of a certain supplier and how they have been 
doing this quarter compared to last quarter. 
 
Choose the Supplier Code, an Analysis of Percent Rejected or Percent late and choose Grouped By Week, Month 
or Quarter, click the Chart button and a chart will appear comparing the two time frames.  

 
The example shown here is a Supplier with 70 percent rejection of materials received from August to November 
of 1999 and from 10 to 100 percent rejected in the months of February to July of 2000. 
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Chapter 12:  
Setup 
Setup Menu 
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Settings 
To set up SUPPLIERtrak, go to the Setup icon on the Main Menu and select Settings. Settings are where you 
enter the Company information, the contact name, the logo and user defined fields. The following window will 
appear, showing the four tabs, the first is for User Information: 

 

User Information Entry  
Field/Button Name Description 
Company 
Information 
 

Enter your company name, address, phone/fax numbers, and logo (optional). The two 
lines for your company name and logo will appear at the top of all reports. If you have 
not set up the users, the information from the Contact field will be displayed next to 
“User” in the lower left corner of the main menu. 

Paste Logo and  
Insert Object 

To enter your company logo, use the Insert Object or Paste buttons. Use Insert Object if 
you already have a logo file or want to create the logo in a graphics program and link it 
to SUPPLIERtrak. Use the Paste button if you’ve copied the logo to Windows Clipboard.  
 
Try to insert a logo graphic about the same size as the logo region shown. Otherwise, 
you might not have enough memory available to print the logo on your reports. Also, to 
avoid wasting memory, don’t use a logo with more colors than your printer can print.  

 

You can use a scanner to obtain your logo. A logo created this way can become a huge 
file that uses an excessive amount of memory. To conserve memory, paste your logo 
into SUPPLIERtrak as a .BMP file, even if you created it in a graphics program. Pasting 
your logo as a bitmapped object uses less memory. If you can view your logo in the 
Settings window, but it doesn’t appear on your reports, you don’t have enough memory 
for the logo size (in bytes) that you’ve used. 
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Field/Button Name Description 
Close If you want to save your changes, click Exit to return to the main menu. 
Cancel To exit this screen without saving your changes, click the Cancel button. 

General  

 
 

Field/Button Name Description 
Enable Audit Trail The Audit Trail feature, when enabled, will keep a text file of actions taken during use of 

the program, such as record modifications and deletions. The user who performs each 
action will also be listed. Click in this box to enable the Audit Trail feature. 

Select Text Editor Choose a default text editor program, such as NotePad, to use for viewing the audit trail 
file. 

Audit Location SUPPLIERtrak puts the audit trail file in the directory you designate in this field. 

Tip: If you are sharing the SUPPLIERtrak database on a network drive, locate 
your audit log in the same folder. 

View Audit Trail Click this button to see your audit trail file. 
User Defined Fields  
User 1 and User 2 

These user-defined fields will change the two User Defined field names in Supplier Entry, 
Part Entry, Received Material Entry and Reject Material Entry respectively. The fields have 
a 50-character limit. 

Late and Early Grace 
Period 
 
 

Whenever a received material record is added, the program will examine the Due Date and 
Received Date and mark the record as either Early or Late. The program allows you to set 
up both Early and Late grace periods for your suppliers. The Late Grace Period is the 
number of days that a supplier is allowed to be late. 
The Early Grace Period is the number of days that a supplier is allowed to ship early. 
Companies that are using Just-In-Time (JIT) policies with their suppliers may want to 
allow them be early without penalty. Set the Early grace period to the desired number of 
days. If you don’t want to penalize the supplier for shipping early, then set the Early grace 
period to 999 days. 

Corrective Action 
Statement 

At the bottom of the window is the default corrective action statement, which will be 
included when creating rejection records (discussed on page Error! Bookmark not defined. 
of this manual). As with all memo fields in SUPPLIERtrak, press CTRL-ENTER to insert 
new lines into this field (pressing ENTER by itself takes you to the next field). This field will 
scroll up (and down) to allow for longer statements.  

Page Employee Number of Seconds to pause when calling an employee pager. Requires AT compatible 
modem installed and configured on workstation. 

Alarms These three checkboxes will globally either enable (checked) or disable the alarm features 
in SUPPLIERtrak. 
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Field/Button Name Description 
Currency Enter Currency Symbols, a description and conversion factor for the currencies you expect 

to be using in SUPPLIERtrak. Copy and Paste from the Windows Character Map. 
Remember to update your conversion factors to their current values before running 
Rejection reports. 

Maintain Receiving 
Procedure History 

This checkmark controls whether or not Receiving Procedure History is enforced on the 
Procedure Entry form.  The default for this  checkmark  will be checked and locked. 

Settings—Interface 
Changing Field Labels in SUPPLIERtrak  

You can rename any SUPPLIERtrak field to better suit your needs. For example, your company might use the 
term “Dock Entry code” instead of “Receiving Log No”. You can then change the Receiving Log No field to “Dock 
Entry Code”. To change field names, go to the main information screen for any record entry form, and then click 
in the upper left corner of the form. Another screen will open: 

 
 

In this screen, you can change any of the field names that appear. Your changes will appear anywhere in 
SUPPLIERtrak where the field appears. To change a field’s label, go to its Label Text box and make the 
necessary changes. You can also choose to make field labels bold or normal in appearance. The fields and 
buttons in this screen are explained in the following table:  
Field/Button Name Description 

Font Weight Click this button to change the font weight of other labels to the opposite of the current field. 
For example, if you click this button while in a field marked “Bold”, SUPPLIERtrak asks if you 
want to change the weight of the other fields to “Normal.” 

Open Normally Select this option to see your custom field labels. 

Open with default 
label text 

Use this button to temporarily change field labels back to their default names. This button is 
useful if, for example, you need to contact Technical Support about a question on a particular 
field and need the original field name.  

 
The Settings—Interface window displays a complete list of user customizable interface elements. These are 
broken down into the following tabs: Custom Labels, Form Captions, Form Tabs, Main Menu, Menu Bar, 
Messages and Menu Colors. All of these elements are completely customizable. You can use these to rename 
interface elements to fit your company’s terminology, or even translate SUPPLIERtrak’ interface into a 
language other than English. 

Changing Menu Colors on SUPPLIERtrak 
You can also customize the user interface of your application. For example, you find the green background a bit 
dull for your tastes you can change the color in the Menu Colors tab in Settings—Interface. 
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This screen allows you to modify the icons’ foreground and background shades, as well as font colors to 
something more visually pleasing for you. As you customize the user interface, your choices for each element 
you modify are displayed in the Preview window to your right. This allows you to view your changes immediately, 
saving you time and effort. 

Settings—Skip Dates and Days 
Entering Skip Days and Dates in SUPPLIERtrak  

On the Skip Days tab of Settings, you can use the checkboxes for the days of the week your facility wants to 
remove from the calculation of Early and Late for receiving Records, and Next Rating due dates for Suppliers. 

 
Also, choose the global skip direction for calculating next rating due dates for suppliers when the calculated 
date falls on either a skip day or date. 
 
Enter Skip Dates in the table on the right. For example, enter each holiday in the coming year when the plant 
will be shut down, also one entry for each day of a two week planned plant shutdown during the summer. 
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Rating/Survey Wizard 
You can use the Rating/Survey Wizard to create a new rating or survey or to modify one that has previously been 
created using the Wizard. To enter a new rating or survey using the Wizard, choose Rating/Survey Wizard from 
the Tools and Utilities menu. 

 
Important Note: Ratings or surveys created without the Wizard cannot be modified using the Wizard. Any 
ratings or surveys that are modified will affect future ratings or surveys only; previous supplier ratings or 
surveys will not be changed. 

In the first field, enter your two-character identifier for the rating code or survey code. In the center field, 
indicate whether you are creating or modifying a new rating or a new survey. Use the rightmost field to enter a 
description for your new rating or survey. After you have filled in these three fields, click the Next button to open 
the next entry screen.  

 

You can enter as many categories as you need for your rating or survey. You must assign a category weight to 
each of your categories; this figure can be a whole number or a decimal. Click the Next button when you have 
finished entering all of the categories and category weights. 
 
Click the Rating/Survey Structure button to view the relationship of categories and their criteria. 
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You may enter as many criteria for each category name as is necessary. The criteria weight can be a whole 
number or a decimal. When you have finished entering your criteria names and criteria weights for your first 
category, click the right pointing arrow above Criteria Weight entry. 

 

Use the left and right navigating arrows above Criteria Weight entry to enter and view all criteria records for 
your different categories. 
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When you have finished entering criteria for your last category, click the Finish button to create the new rating 
or survey. The following Record Created message will appear to confirm that the new rating or survey was 
created: 

 
 

Set Up Users 
When you select Set Up Users from the Tools and Utilities menu, the User Entry screen will appear.  
 
The Set Up Users feature allows you to add new SUPPLIERtrak users and set each one’s rights for each of the 
program areas.  

User Information  
Field/Button Name Description 
New Click the New button to add a new user to SUPPLIERtrak. 
Undo Click the Undo button to undo any changes or typing to the field, or press the ESC 

key. 
Delete Click the Delete key of the record of the user you are viewing, and this will remove 

that user. 
Close Click the Close button to save the settings and return to the main menu.  

 
The User Information screen allows you to enter each user that will be using SUPPLIERtrak, and assign a PIN to 
each, as seen below: 

 
 

Field/Button Name Description 
PIN Each user should have a unique PIN (Personal Identification Number), a four-digit 

number used to log on to SUPPLIERtrak. 
Name, Title, Location, 
and Phone 

In these fields, enter information about the user, including his or her name, job title, 
location (or department), and phone number.  
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Record Access 
The Record Access screen lists each of the program areas for the user’s privileges. After entering the User 
Information and PINs in User Information, proceed with this screen to complete the process for each user.  

 

 
The privileges are as follows:  
Field/Button Name Description 
Access Access indicates that the user can get into this area of the program. If the user has only this 

box checked, he or she can only view records. 
Add Mark this box to let the user add new records in that area of the program. 
Modify Check this box to let the user edit existing records in this program area. 
Delete If you check this box, you allow the user to delete records in this area.  

Important: If the user has permission to delete records, then the user automatically 
has permission to modify records. 

Access to Reports 
Printing Menu 

The Access to Reports Menu and Printing checkbox allows the user to print  reports from 
the Reports menu as well as printing from the data entry screens (i.e., selecting File | Print 
while in a data entry screen).  

Access to Graph 
Printing Menu 

The Access to Graph Printing Menu checkbox allows the user to get into all graphs and 
charts in that menu.   

Access to Data 
Tools  
and Utilities Menu 
 

The Access to both the Data Tools and the Utilities Menus checkbox allows the user to get 
into all program data tools and utilities, including the access to the Modify License screen. 
Mainly supervisors should be given this permission. 

Access to Setup 
Menu 

The Access to the Program Setup Menu checkbox allows the user to get into all program 
setup utilities, including the access to the User Setup screen. Only supervisors should be 
given this permission.  

Time-Saving Tip: You can click on any of the vertical (Access, Add, Modify, Delete) or horizontal (Suppliers, 
Parts, Rec. Material, Ratings, Surveys) items to toggle the entire column or row on or off. 

 
When you have completed the Access rights for the user, click Close to return to the Main Menu. 
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Report Control ID Entry 
Report Control IDs 

If your company needs to comply with ISO or QS 9000 Document Identification and Control requirements, select 
this option from the Tools and Utilities menu. Each report in SUPPLIERtrak can be uniquely identified with a 
different document number. The Document Control ID will appear at the bottom of reports, using the alignment 
you have chosen for that particular report. 

 
If you are not required to use document control numbers, you might want to enter your company’s address and 
telephone numbers as control text to appear on the bottom of your reports. 

Ratings Definition 
Under the Definition Search you can choose a Rating, its Category or Description to view the Definition of the 
Rating as it was entered in the wizard. By pressing the Find button with no other options entered; you will view 
all of the Rating Definitions available. 

 
After choosing the Rating, Category or Description, click the Find button.  
You will see the Rating Code, Category, Description, Formula, and Criteria as they were entered in the 
Rating/Survey Wizard. 
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Survey Definition 
Under the Definition Search you can choose a Survey Code, its Category or Description to view the Definition of 
the Survey as it was entered in the wizard 
 
By pressing the Find button with no other options entered; you will view all of the Survey Definitions available. 

 

 
After choosing the Survey, Category or Description, click the Find button. You will see the Survey Code, 
Category, Description, Formula, and Criteria as they were entered in the Rating/Survey Wizard. 
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Rejection Coding Setup 
Click this button to bring up the Rejection Coding Setup form. This form allows you to edit and add or delete 
Rejection codes from the application. However, any modifications here will not affect previously created 
receiving or reject records in the database. Their historical data integrity will remain intact, and only future 
records will be affected by the modifications made here. 

 
 

Corrective Action Statement Entry 
Click this button to bring up the Corrective Action Statement entry form filter.  

 

 
 

Select the CA Statement you wish to review or edit from the dropdown list, or enter Text in the Corrective Action 
Statement field to search the previously entered statements for occurrences of the criteria text string. Hit Find 
with nothing in the criteria fields to see all CA Statements entered in the CA Statement Entry Form: 
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This form allows you to edit and add or delete Corrective Action Statements (other than the main Default 
Corrective Action Statement found in the Setup – Settings – General Tab) from the application. However, any 
modifications here will not affect previously created reject or reject corrective action records in the database. 
Their historical data integrity will remain intact, and only future records will be affected by the modifications 
made here. 
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Chapter 13:  
Data Tools 
Data Tools Menu 

Backing Up Your Database File 
You should periodically make a backup of your SPDATA46.MDB database file (we recommend doing this every 
day). You can use the built-in Backup/Restore function that is part of the program for accomplishing your 
backup. If you have purchased specialized backup software (such as Colorado Backup tape drive or a zip drive), 
use it instead.  

1. First, gather several pre-formatted, blank diskettes (several may be needed, depending on how 
many records are in your database). To back up, click on the Tool and Utilities button from the 
main menu and select Backup/Restore. This will bring up the Backup/Restore utility.  

  

2. The file name dialog box will appear.  

  

3. Enter the drive and a name for the backup Zip file (if you like, you can use the current date as your 
filename (you could name it like this: YYMMDD.ZIP - for example, August 25, 1999 would be saved 
as 990825.ZIP). 
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NOTE: The drive that you are backing up to must be removable media such as floppy disks or SyQuest 
cartridges - you cannot back up onto your hard drive. It is a good idea to alternate your backup diskettes, so 
that you always have at least your last two backups available. 

Another way to keep track of your backups is to have five or six sets of diskettes (one set labeled for each day of 
the week) and backup your database as SPDATA46.ZIP every day. This way, you will always have a week’s worth 
of backups. You may also want to archive a permanent set of backups on a regular basis as well, perhaps once a 
month.  

1. Next, select the database file to add to your Zip file. Choose your data file 
(SPDATA46.MDB) and click the OK button. 

 
Important Note: If your SUPPLIERtrak database is on your server, you must change the drive letter to your 
network drive and select the appropriate folders, then highlight your SPDATA46.MDB. If you do not know, or 
are not sure, where your SUPPLIERtrak database is located, look at the database location on the lower right 
corner of the SUPPLIERtrak main menu before backing up your database. If you use more than one database 
with your SUPPLIERtrak program, you will want to back up each one of your databases on a separate set of 
labeled diskettes. 

2. Place a blank, pre-formatted diskette in the drive and click the OK button when ready. 

 

3. A progress meter will be displayed that will show you the percentage completion. If the 
backup requires more than one diskette, you will be prompted to insert another. 

 
Your data is now backed up. You should clearly label the backup diskette(s) with the date (or day of the week) 
and diskette number for future reference. 
 
The resultant backup files will be in a highly compressed, industry standard ZIP format. This means that other 
utilities, such as PKZIP, PC-Tools, WinZip, and Norton, can also be used to restore your backup file. 

Restoring Data 
If you need to restore your database file, place your backup diskette in the drive and click on the Restore button 
found in the Backup/Restore menu. If your backup took more than one diskette, then insert the last disk of the set. 
 
A dialog box will appear, and you can choose the file you want to restore. Highlight your data file and click the 
Open button. 
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Now choose the drive and directory to which you want to restore the backup Zip file. 

 
Important Note: When you restore your database, you must restore it to a different location than your 
current database location. This will prevent you from accidentally overwriting your current database. This 
safeguard will allow you to alternately open your restored and current databases to compare them in the 
event of suspected data loss caused by a corrupted database. 

 
Click the OK button to begin the restore operation. 
 

Note: If your hard drive has been replaced (or you are installing the software to another computer), you will need 
to first re-install the SUPPLIERtrak program —then restore your backup database file. 
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Import/Export Utility 
Exporting Data 

For your convenience, SUPPLIERtrak includes an automated export program. To export or import data, go to 
the Tools and Utilities menu and select Export/Import. This screen will appear: 

 
To export information from SUPPLIERtrak, select the Export tab. You can copy data from SUPPLIERtrak into a 
new text file or  spreadsheet. Each table that you can export has a corresponding filename, so you don’t need to 
name your export files. The filenames are based upon the destination/source tables plus the appropriate 
extension for the file type. For example, a text file from the Parts Master table will be named PARTS.TXT; the 
same file sent to an Excel file will be named PARTS.XLS.  

   
Table Name Export Filename Helpful Information 
Receiving Receiv Includes all of the information seen on the Received Material Entry screen for all 

log numbers. 
Rejects Rejects Shows Rejected Material Log numbers, Dates, Type, Code and Part numbers. 
Supplier Master Supplier The Supplier table stores all of your supplier information, as in Supplier Master 

Entry. 
Supplier Parts Parts Table includes the Part Number, Company, Description and Dates.  

 
After you’ve selected one or more tables to export, click the Export Table(s) button. 

 
The Export program automatically sends the file(s) to the same directory as your database file. In this case, you 
would find two files in your directory called receiv.xls and supplier.xls. When it’s finished, a message tells you 
that SUPPLIERtrak successfully exported the tables.  
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Importing Data 
You can import data into the same tables from which you can export, using the same filenames and file types as 
for the Export utility. 

 

The easiest way to import data is to first export data from SUPPLIERtrak’s empty database to the file format of 
your choice. You’ll then have the exact import configuration in place for the file. Next, open the file and duplicate 
its configuration for a file you already have or add the records you want to import to the file created by the 
export. In order to import files, you must name them as shown, with the appropriate file extension of .TXT or 
.XLS. Do not rename the files you Export, if you plan to Import them back in, the result would be an 
unsuccessful import of data. Make sure that you put the files you’re importing into the same directory as your 
SUPPLIERtrak database file.  





 

155 

Chapter 14: 
Utilities 
Utilities Menu 

Archive/Un-Archive Receiving Data 
Archiving Receiving Records 

The Archiving function in SUPPLIERtrak no longer moves your old receiving records from your working 
database file into a separate archive file. For your convenience, archived records are now stored in your 
SUPPLIERtrak database, SPDATA46.MDB. As with the previous archiving method, this will speed up your 
reports and data entry forms since they will not have to work with as many records. Use this utility to archive or 
un-archive your receiving records.  
 
Archive moves your records from the current group and puts them in a storage location within the database. 
This makes your current group of records smaller and your database faster. An archive is not the same as a 
backup. To un-archive your receiving records and combine them with your current records, you can use the Un-
Archive function. 

Remember: Always make a backup copy of your SPDATA46.MDB file before you archive it! 

 
When you select this feature from Tools and Utilities, the following filter will appear: 

 
You can archive your records either by Log Numbers or by known dates received. To archive, enter the 
beginning date in the From Date Received field and the ending date in the To Date Received field. Click the 
Archive button when you’re ready. 
 
Archived records are stored within the database. After you archive records, you can decrease the size of your 
data file by running Compact Database from the SUPPLIERtrak program group or from the Data Tools Section. 
To view the archived records, click the View Receiving or View Reject buttons. To put archived records back into 
the current record group, set up the criteria in this screen and click Un-Archive. 
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Archive/Un-Archive Suppliers 
The Suppliers archive works the same as the Receiving Data Archive; the archived records are stored in your 
SPDATA46.MDB database. Use this utility to archive or un-archive your supplier records.  
An archive is not the same as a backup. 

Remember: Always make a backup copy of your SPDATA46.MDB file before you archive it! 

1. When you choose the Archive/Un-archive Supplier from Tools and Utilities, you will see 
the following window. Your first step is to choose a Supplier to Archive from the 
Suppliers drop down list.  

  

2. After selecting a Supplier, click the Archive button. 
3. The message: “Archive Complete” will appear when the Archive is done.  
4. To return to the main menu, click the Close button. 
5. To un-archive your supplier records and combine them with your current records, you 

can use the Un-Archive function. To Un-Archive, choose a Supplier that has already been 
archived, from the drop down list. 

   

6. Next, click the Un-Archive button.  
7. When the Un-Archive is complete, you will see a message.  
8. You can verify the data has been Un-Archived by going back to the Supplier Master Entry and 

choosing the Supplier from the drop down list. 
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Edit All Tables 
To edit data tables directly, choose Edit All Tables from the Tools and Utilities menu. The Edit All Tables menu 
will appear. This utility allows you to enter data or modify SUPPLIERtrak’s data tables. 

WARNING! When editing data from this utility, you are editing the tables directly - none of the SUPPLIERtrak 
features and safeguards that protect users from various data entry errors or relational integrity corruption 
are in place. Exercise extreme caution when using this feature. 

 
Double-click on the name of the table you wish to edit, and you will be presented with a spreadsheet-like view of 
the information.  

 
 

Reset Early/Late 
This utility will mark the early or late flags of all receiving records based upon the early and late grace periods 
in 'Settings'. This Utility is usually used when wishing to update all past historical Receiving records that are un-
archived after updating the Early or Late Grace period settings in Setup – Settings – General tab. 

 

Update Supplier Next Rating Due 
This utility will reset all Supplier Next Rating Due dates for those Suppliers with Ratings Frequencies selected 
and also a valid Last Rating date entered.





 

 

Appendix 
Data Transfer Utility 

The Data Transfer Utility Wizard has three options: 
• Run Scripts—this option is for users who have opted to use an ODBC database to store their data. 

When the Run Scripts utility is ran the utility will run the scripts needed to build the tables. 
• Transfer Data—this option is used to migrate data from older versions of our software to upgraded 

versions e.g. SUPPLIERtrak 4.5x to SUPPLIERtrak 4.6. 
 

Use this utility only once—when you install your new SUPPLIERtrak and need to transfer your data from an 
older version of SUPPLIERtrak.  

 
Running the DTU overwrites your SUPPLIERtrak destination database. You need to run the DTU because new 
fields and tables have been added to SUPPLIERtrak. After you run the DTU, your records will be in both your old 
and new versions of SUPPLIERtrak. However, don’t use your old version of SUPPLIERtrak; enter all new 
records into your new version of SUPPLIERtrak. 

 

Running the Data Transfer Utility: 
To run the Data Transfer Utility, click the Start button, select Programs, and then select the SUPPLIERtrak 4.6 
program group. Choose Data Transfer Utility from this program group to use the Data Transfer Utility. 

 

Client/Server Versions—Before You Run the DTU: 
If you’re using a client/server version of SUPPLIERtrak, you must run scripts to set up your database and tables 
before you transfer your data. To do so, click the Run Scripts button on the main DTU screen. 
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The Run Scripts screen will appear. The table below contains information about the fields and buttons in this 
screen. 

 
 

Field/Button Name Description 

Script Path and 
Browse 

This field contains the location of the “Scripts” file for the current workstation. It defaults to the 
same path that the DTU is in for the current workstation.  
If this path is incorrect, a message similar to the message below will appear: 

 

Select OK, and then click on Browse to find the directory where the “Scripts” file is located. 

Data File Name Enter the name and server location of the GAGEtrak 6 data file. The letter for the drive must be its 
physical drive letter, not a mapped letter. For example, if your server has a physical drive (D) that’s 
mapped to as a different letter (F), enter D followed by the rest of the path.  Remember to include 
“.MDF “ (master database file) as the file extension. 

Log File Name  
(MS SQL only) 

MS SQL users should enter the name and server location of the log file. We recommend that you 
use the same path as for the data file (again, using the drive letter of the physical drive).  
Remember to include “.LDF “ (library definition file) as the file extension. 

Administrator User ID 
and Password 

Enter the Administrator User ID = SA, and password of your database administrator. 

Server (MS SQL only) MS SQL users must enter the server name in this field. For example, if the server name is 
“Company_NT”, enter that name in this field. 

Service Name Not supported. 

Run When you’ve finished entering all of the necessary information, click this button to run the scripts. 

Test Connection Click this button to make sure that you’re connected to the correct path before you run the scripts. 

Cancel To exit this screen without running the scripts, click Cancel to return to the main DTU screen. 
 

When you’re finished running the scripts, you can begin transferring data and/or updating or adding reports. 
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Data Transfer Instructions Versions 4.ox and 4.5x to New Version 4.6x: 
Converting your database file—SPDATA40.MDB and SPDATA45.MDB 

 

1. Select Next to bring up Page Two of Three of the DTU to select your source Database. 

2. The DTU must be run twice only for customers with New ODBC databases. Then you must select 
Version 4.6 NEW as the source on Page Two, this will disable the Browse button to select a source 
database because the Source of the NEW is default tables contained within the DTU. 
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For users transferring existing data to the new 4.6 Destination database, the instructions are different from 
selecting Version 4.6 NEW. 

 
1. Select the version of the source database, 4.0 or 4.5 or 4.6 from the source database dropdown on 

page two. 
2. Use the browse button to search for your source data file. 

 

 
 

Browse will bring up a common dialog File Open window: 
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After selecting the file, Select the large Test button at the bottom of the Open Database form. If the connection 
fails for any reason, this pop up error will appear: 

 
 

 
 

If the Test returns successful, this Pop Up will appear: 
 

 
 

Then, Click OK to select this database as your source database. 
 
This will bring you back to page Two of the DTU with your selection of the source data displayed in the Source 
Connection Information control. 
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Then, click Next to go to Page Three of the DTU to select your destination database. This data will always have 
to be selected from the dropdown list and the only Item in the list is Version 4.6 Data. 

 

 
 

Again, select the browse button to bring up the Open Database form to select the Destination version 4.6 
database. The example shown here shows connection information for an ODBC Database with a text Alternate 
field shown for clarity. 
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Then, Click Test and OK just as when selecting the Source Database and Then, when returned to Page Three of 
the DTU with a successful destination connection, the Transfer Data Button will be Enabled. 
Click Transfer Data to begin the data transfer. You will get the following Pop Up warning: 

 

 
 
 

Click OK to continue with the transfer.  
 

Note: If the Source and Destination file path are identical you will be presented with the following message and 
you must redefine you file paths: 

 

 

Verify Data Transfer 
After you click Transfer Data, SUPPLIERtrak automatically moves your records into the new database.  
 
The DTU will give you a complete acknowledgement of its activities in the lower left windows status bar during 
the entire transfer operation. 
 
When it is complete, you will see this message: 

 
Click OK, then SUPPLIERtrak will show you a screen where you can check the transfer and verify that it was 
successful. This screen is different for each version, but the general instructions are the same. 
 
The Record Count values should match in both the Source and Destination tables for those table names that 
appear in both sections. You can ignore the table names on the Destination list that have no corresponding 
name on the Source list; these are SUPPLIERtrak’s new tables (the report control table will always be higher on 
the Destination side when you are transferring data from Version 3).  
 
If the counts for the tables that appear in both sections don’t match, print the form (select File | Print) and 
contact Technical Support at (480) 922-7300 for assistance. 
 



 Appendix 

 

166 

Note: Due to previous versions of SUPPLIERtrak not maintaining a field for Quantity Rejected in 
the Rejects table, the Data Transfer Utility will populate the field for Quantity Rejected for each 
reject record related to any given receiving record from the Quantity Rejected field on the main 
Received Material Entry form (Receiving table). Please refer to the description of how version 4.6 
handles tallying of individual Quantity Rejected amounts from all reject records associated to any 
given receiving record in the Received Material Entry section of the manual on page 94. 

 
Click the Finish button to return to the main DTU window. 

Sample of Data Transfer: 

 

 

Database Management 
Create a New SUPPLIERtrak Database 

You can use multiple databases with SUPPLIERtrak. For your convenience, the program installs an empty data 
file in the same location as your database (named SPDATA46.EMP). Copy this empty data file for each additional 
database that you want to use.  

 
Important: Currently, no easy method exists for transferring records between databases. Although you can 
use the Copy and Paste approach, it’s cumbersome and error-prone; you must be extremely careful and 
fully understand the data table relationships. Please consider this if you decide to use multiple databases. If 
you do use multiple database files and later want to merge them, please contact Technical Support for 
assistance (there may be a small charge for this service). 

Loading Database Files 
Creating Another Database File 
SUPPLIERtrak can be used with multiple databases if you wish. To do so: 

1. Create a new directory in which to store your new database file. Use File Manager, My Computer, 
or Windows Explorer to create the new directory. 

2. Copy the file SPDATA46.EMP from the C:\SPW46 directory to your new directory (SPDATA46.EMP 
is an empty database file without any records in it). Then, change the file name in your new 
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directory to “SPDATA46.MDB”. This can most easily be done using the Windows File Manager, My 
Computer or Windows Explorer program. 

To Load a Different Database File 
To attach to a new data file select File | Open Database from the main menu. This will bring up a file open dialog 
so you can choose a data file. 

Viewing the Current Database File  
To see which database file you are currently using, look at the bottom of the main menu screen. 

Compact/Repair Database 
Click on the Start menu, go to Programs, and choose the SUPPLIERtrak 4.6 menu and then Repair Database. 
 
When the repair is complete, you will see a message saying the repair was successful.   
 
Click OK, and return to SUPPLIERtrak.  
 
Whenever you delete a record, the program doesn’t actually delete the record—it only marks it as deleted and 
then re-uses it whenever you add new records (i.e., your data file size does not decrease). If you delete many 
records, you should compact your data file so that the program actually removes these records, decreasing the 
size of the data file.  

SUPPLIERtrak Help 
You can use SUPPLIERtrak’s on-line Help feature by selecting the Help menu or pressing the F1 function key. 
You can select from different topics listed in the Help Contents or you can search through an alphabetical list of 
program features. For your convenience, there is a back navigation button and history listing, so you can quickly 
return to recent items. You can print any topic found in SUPPLIERtrak Help. 

Data Table Record Formats 
Key Fields 
A key is a field or combination of fields that is used to uniquely identify each record in a table. If the Data Type 
column contains the word “(Key)”, it means that this field or combination of fields is considered to be a key field.  

Combination Key Fields 
The example table format below shows combination key fields (there are two key fields identified).  

Name Data Type Size 
Supplier Code Text (Key) 16 
Supplier Part No Text (Key) 20 

 
This means that the following data table would be acceptable: 
Supplier Code  Supplier Part No 
100-10-E   86A-1276-D  
100-10-E   55Q-5543-X 
 
Whereas the following data table would not be acceptable: 
Supplier Code  Supplier Part No 
100-10-E   86A-1276-D 
100-10-E   86A-1276-D 
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Data Table Record Formats 
The formats of the records within three of the database tables are summarized below.  

 

Table Name: Supplier Master 
Key Field: Supplier Code 
Columns:  
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Table Name: Supplier Parts 
Key Field: Supplier Code 
Key Field: Supplier Part No 
Columns: 
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Table Name: Receiving 
Key Field: Receiving Log No 
Columns: 

 
If you need data table formats for other tables, please contact Technical Support at (480) 922-7300.  

Compacting Your Data File 
Whenever you delete a record, the record is not actually deleted - it is only marked as deleted and then re-used 
whenever you add new records (i.e., the data file size does not decrease). In the event that you delete many 
records, you may want to compact your data file so that all the records that are marked as deleted are actually 
deleted, and the data file is reduced in size.  This can be done from within the Running Application. Just go to 
the Data Tools area, and then click on Compact / Repair Data.  When this Tool Executes, your company name at 
the top of the Main Menu will change to #Name? It will remain that way until the Repair tool terminates, then 
the Main Menu will reconnect to the database and your company name will re-appear just as it was before. 
 
The Compact / Repair can also be done by clicking on the Compact Data icon found in the SUPPLIERtrak 
program group window. 

 
If you receive any error messages when running the Compact Data utility, write them down and contact 
Technical Support immediately at (480) 922-7300 for additional instructions. 
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Troubleshooting Problems 
Repairing Data Files 
Although SUPPLIERtrak has been designed to be as trouble-free as possible, error messages may appear 
because of occurrences like power outages, accidental resetting of your computer, network disconnects, and 
other mishaps. In these cases, it is possible that your data file (SPDATA46.MDB) will need to be repaired and 
compacted. You can do this by clicking on the Compact Data icon in the SUPPLIERtrak group window. 
Depending on the size of your file, this may take several minutes to complete. Network users should make sure 
that no one else is running SUPPLIERtrak while performing this operation. 
 
If you receive any error messages during the repair process, be sure to write them down, and if the original 
error message persists when you’re trying to run the program, contact Technical Support immediately at  
(480) 922-7300 for additional instructions. 

Duplicate Value in Index - Error Message 
This error message may appear when you enter two records with the same key field values (see page 167 for 
more information about key fields). Examples include: 

 Entering two suppliers with the same supplier code. 
 Entering two parts with the same part number for the same supplier. 
 Entering two procedures with the same procedure name for the same supplier or part. 

 
If this error message appears, click the OK button, then click the Undo button, or choose Undo from the pull-
down Edit menu.  

Network Installation 
Before you install SUPPLIERtrak on a network, you must be familiar with the network policies for file and 
program locations, and you must be certain that all users have full rights (create, change, and delete rights) for 
the appropriate files and directories. You must also have a network license of the SUPPLIERtrak software.  
 
Normally, the SUPPLIERtrak software must be installed to each workstation that will use the program. For 
maximum performance of SUPPLIERtrak with multiple users, we recommend installation of SUPPLIERtrak 
program files on each local workstation, with a shared database file (SPDATA46.MDB) on your server. 

Windows Is Located on Each Local Workstation 
Typically, each user on a network runs Windows from their local workstation’s hard drive. SUPPLIERtrak must 
be installed on that local workstation and every other workstation on the network on which it will be used. 
 
Installing SUPPLIERtrak onto one workstation and simply copying the files to another workstation from the 
network will not work. SUPPLIERtrak’s setup program needs to register entries in the Windows Registry, 
update out-of-date DLL files, font files, create icons, and perform other setup tasks. However, to make things 
easier, you may copy the contents of the program CD to a designated network directory and have each 
workstation run the installation program “SETUP.EXE” from the network.  
 
For example, you could copy all of the SUPPLIERtrak diskettes to the network server directory F:\STWSETUP, 
and then instruct your SUPPLIERtrak users to run the SETUP.EXE file located in F:\STWSETUP. 

Windows Run From the Server (“Served Copy of Windows”) 
If your network is set up so that Windows is located and run exclusively from your network server, then 
SUPPLIERtrak may be installed and run on the server. However, whoever installs SUPPLIERtrak to the server 
must be a supervisor with full rights to the shared Windows registry and the shared Windows DLL files. Be 
advised that SUPPLIERtrak will run slowly in this configuration since both the program and data must be 
delivered to the user workstation via the network cable. 
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Chapter 1: 
Installation 

You can use SUPPLIERtrak 4.6 on a single workstation, on a network, or in a client/server environment – 
installation will vary slightly for each of these options. This chapter gives you general installation instructions 
for all options.  Chapter 2 deals with setting up a MS SQL client server system.  

Program Requirements  
SUPPLIERtrak 4.6 for Windows requires the following:  

• Microsoft Windows 98SE, 2000, XP 

• Hard disk with 700 MB of free space for program files and 25-50 MB of free space for typical 

database  
• 512 MB RAM or more  
• VGA or compatible display monitor  
• Mouse or compatible pointing device  
• Printer (if you want to print reports; ink jet, bubble jet, or laser printer is best)  
• IBM PC or 100% compatible computer  
• Pentium 133 MHz or higher CPU  

Installation  
Files  

The setup consists of three files: SETUP.EXE contains all the files required to run SUPPLIERtrak; 
G_CONECT.INI is the initialization file used during installation to configure the user’s database settings; and 
README.TXT notes special features or changes to the program.  

Installation Options  
You can use SUPPLIERtrak 4.6 as a client/server program, with one centralized, dedicated computer hosting 
the database and one or more user workstations accessing the database from that server. You can also choose 
to install and use SUPPLIERtrak on only one PC (a single-user setup).  
 
If you have a multi-user license of SUPPLIERtrak, you and your other SUPPLIERtrak users can install the 
program from the CD or from a network location.  If you want your users to install from a network location, 
copy the SETUP.EXE and G_CONECT.INI files to the same network location, and then instruct users to run 
SETUP.EXE from that location. You can find the Access or MS SQL G_CONECT.INI file on the CD under the 
directory of the database name (i.e., the Access G_CONECT.INI file is in the Access directory on the CD).  
 
To install SUPPLIERtrak, follow these instructions:  

1. To begin installation, click the Windows Start button and select the Run . . . command. Click the 
Browse button to navigate to your CD-ROM or network drive, then select SETUP.EXE  

The sample screens show a CD and a network installation. 
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2.  Next, you’ll see the Welcome screen. Make sure that you’ve closed all other programs, and then click 
Next.  

 

In the next screen, enter the install code for your copy of SUPPLIERtrak. You can find this code on the CD 
envelope that came with your software package.  

 
Tip: If you don’t have an install code, leave this field blank.  

 

3. Now the installation program will tell you that you will be choosing the location for the program on 
your hard drive.  Since this location is specific to each workstation, do not select a network location. 
We recommend using the default directory—C:\Program Files\SPW46.  

4. Unless you’re using the program with a MS SQL database, the installation program will now let you 
select a location for the SUPPLIERtrak database. If you are using SUPPLIERtrak in a client/server 
environment, skip to step 5.  
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If you are using the program on a single workstation, select the default directory – C:\Program Files\SPW46.  If 
you have a network license of the program and are using it with an Access database, click the Browse button 
and select the network directory where you will store your database. If you are running the setup from a 
network drive, the path to the SETUP.EXE file will be the default database location.  

Note: If your Windows Registry already lists a directory for the SUPPLIERtrak 4.6 database file, that directory 
information will appear in this screen. Go to step 5.  
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The Browse button will allow you to specify a location on any file server directory where the anticipated range of 
SUPPLIERtrak users have been given Full Rights. This form is a directory level browse only: 

 

 

1. Next, SUPPLIERtrak will ask if you want it to create backup copies of all of the files that it overwrites 
on your system. We recommend that you select Yes and use the default location (C:\Program 
Files\SPW46\BACKUP).  

2. If you’re using a SQL version of SUPPLERtrak, the installation program now asks where you want to 
install the database scripts. Click the Browse button to select a location.  If you don’t want to install the 
scripts, remove the check from the Install MS SQL Scripts box.  

3. Next, SUPPLIERtrak will ask if you want to install under the Common Users Group or the Current User 
only. It is recommended that you install under the Common User Group. 

4. Now the program will ask you to select the Program Manager group to add SUPPLIERtrak’s icons to. 
We recommend that you select the default—SUPPLIERtrak 4.6.  

5. Click Next, and this screen will appear:  
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10. Click Next to begin the installation.  During Installation you will see the following Windows Installer 
popup; this will appear when the installer is almost done: 

 

When it’s finished, you’ll see this screen:  
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After you’ve read the information about the database location, click Finish. If additional files are required for 
SUPPLIERtrak 4.6 to run, they will install now. Follow the instructions on your screen to install any additional 
files.  

Important Note: During user workstation installations from your network, SUPPLIERtrak will look for the 
appropriate program settings in the configuration file (G_CONECT.INI) in the network directory. If it doesn’t find 
them there, it will check the workstation’s Windows Registry and use the settings there. If the settings aren’t in 
either of these locations, the program will use the default information (MS Access).  

Please note that Technical Support is not available for the creation of your client/server database.  
  

After You Install SUPPLIERtrak  
If you’re upgrading from a previous version of SUPPLIERtrak, you will need to run the Data Transfer Utility 
before you begin using the program. Please see Appendix A:  Data Transfer Utility, beginning on page 209, for 
complete instructions.  If you’re using SUPPLIERtrak in a client/server environment, first follow these steps to 
configure it with your MS SQL database:  

Administrator Installation  
To complete the administrator setup, follow these steps:  

Note: You will need to do this only once for an administrator setup.  To set up each 
workstation, follow steps 3-10. 
 

1. Run the appropriate scripts for your server to create the database and tables.  The scripts are located 
in the GTW4\SCRIPTS directory. The files have prefixes to their names (Step1, Step2…) to indicate the 
order in which you should run them. You might need to modify the data file in the table space for your 
system. See the Step 1 script for details.  

2. Next, run SUPPLIERtrak’s Data Transfer Utility Version 4.6 to import existing data from a previous 
version or pre-fill the database.  

3. Open SUPPLIERtrak 4.6 and select Open Database from the File menu.  

4. In the Open Database screen, check the Use ODBC checkbox.  

5. Place a check in the Use DSN checkbox.  

Important:  If you used a different Database Name, DSN, User ID, and/or Password during installation, enter the 
information you used instead of the values listed below.  If you set up the configuration file (G_CONNECT.INI), 
GAGEtrak will automatically fill in these fields in this screen.  

6. The Database Name should read spw46 (or the name that you entered during installation).  
7. The DSN field should show MSSQL_SPW46 (the DSN that you entered during installation; this value 

may be different).  
8. Your user ID should be spw46 (this field may also vary according to your setup). 
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9. The Password field should contain the password you entered during installation. Note that the 
password is displayed as asterisks for security purposes.  

10. Your screen should look similar the one below (shown set up for a SQL 
version). When you’re finished, click OK. 

 

 

Configuration File Settings  
If you want to reconfigure your G_CONECT.INI file, follow these guidelines:  

Note: The brackets (<x>) contain instructions about the information you should enter after the equal sign (=) on 
each line.  

[Database] 
dbType=<0 for a Microsoft Access Database, 1 for a client/server database> 
UseDSN=<0 for No, 1 for Yes (used only for client/server)> 
UseFileDSN=<0 for No, 1 for Yes (used only for client/server)> 
File=<Name of the database file (used for Microsoft Access Database)> 
Path=<Path (mapped drive or UNC) to the database file (used for Microsoft Access Database)> 
DSN=<Data Source Name for the database (used for DSN)> 
FileDSN=<Name and path (mapped drive or UNC) of the DSN file (used with FileDSN)> 
Driver=<Driver name (only if not using FileDSN or DSN)> 
Server=<Name of the server (used for Microsoft SQL Sever)> 
Database=<Name of the database (used for client/server)> 
UID=<User ID (used only for client/server)> 
PWD=<Password (used only for client/server)> 
APA=<Application Attributes (used only for client/server) (not required)> 
DBA=<Database Attribute (used only for client/server) (not required)> 
DBQ=<Service Name (required in some instances if not using DSN or FileDSN)> 
PFC=<Prefetch Count (used only for client/server) (not required)> 
TLL=<Translation Library Name (used only for client/server) (not required)> 
TLO=<Translation Option (used only for client/server) (not required)> 

[Network] 
LicensePath=<Path (mapped drive or UNC) to the license file.> 
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Sample Configuration  
The following sample is for a single-user, Access database version of SUPPLIERtrak 4.6. 

 
[Database] 
dbType=0 
UseDSN= 
UseFileDSN= 
File=SPData46.mdb 
Path=C:\Program Files/SPW46 
DSN= 
FileDSN= 
Driver= 
Server= 
Database= 
UID= 
PWD= 
APA= 
DBA= 
DBQ= 
PFC= 
TLL= 
TLO= 
 

[Network] 
LicensePath=C:\Program Files\SPW46 
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Chapter 2: MS SQL 
Installation 

If you’re going to use SUPPLIERtrak on a MS SQL client/server system, first install SUPPLIERtrak (see chapter 1 
for instructions), then create the data source name (DSN) for your setup, following the instructions in this 
chapter.  

Create Data Source Name (DSN) for MS SQL  
If you’re using SUPPLIERtrak with an MS SQL server, follow these steps to create your DSN.  

1. Click Start, then select Settings | Control Panel. Double-click the ODBC icon, and the ODBC Data 
Source Administrator window will appear.  

2. Go to the System DSN tab. 

 
 

3. Click the Add button. You’ll see a screen similar to this one:  
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4. Select the SQL Server ODBC driver and click Finish. This screen will appear:  

 
5. Enter MSSQL_GAGEMGR for the data source Name.  

6. In the Description field, enter a brief explanation about the data source.  

7. After you enter the name of the MS SQL server, click Next. This screen will appear:  

 
8. Enter the Login ID and Password for your SQL server, and then click Next.  
9. You’ll see the Configuration screen. If needed, change the default database (check the box next to this 

field and enter or select a new database). 
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10. Now, click the Next button. You should see a screen similar to this one:  

 
 

11. Click Finish. The SQL Server Setup screen will appear.  

12. To check the data source, click Test Data Source. If you don’t want to test it, click OK.  

13. When you’re finished, close the ODBC Data Source Administrator.  

 
 

 



 SUPPLIERtrak™ User’s Manual 

 

187 

Index 

A 
About window...............................................................18, 56 
Accepted Material tags ...............................................46, 97 
active part alarms ...........................................................127 
active supplier alarms ....................................................127 
Adding Records................................................................167 
Alarm Count .................................................................26, 77 
Alarm Date .......................................................27, 33, 77, 83 
All Records Selection Button..........................................64 
Apply Filter/Sort ................................................................69 
archived records......................................................155, 156 
Attribute........................................................................43, 94 
Audit Trail .................................................................137, 142 

B 
Backing Up Data ......................................................155, 156 
Backup ......................................................................149, 150 

C 
Client/Server Versions ...................................................159 
Clone Part ....................................................................35, 85 
Column (Field) Selector Buttons....................................64 
Column Width.....................................................................65 
Compact Data...................................................................170 
Control Menu Icon.............................................................64 
copy records.......................................................................71 
Criteria ................................. 69, 70, 107, 108, 111, 112, 141 
currently logged-in user ............................................18, 56 

D 
Database 

Creating a New Database ..........................................166 
Datasheet Title Bar ...........................................................64 
Datasheet view...................................................................64 
Datasheet View ..................................................................60 
date formats.................................................................20, 58 
Display Hidden Columns ..................................................65 
Document Control ID ......................................................144 
Document Identification and Control ............................144 

E 
Early grace period ...........................................................137 
Edit All Tables ..................................................................157 
Edit Filter/Sort ............................... 22, 30, 37, 69, 74, 79, 87 
Employee ID 

Creating ..................................................................99, 103 
Error Message 

Duplicate Value in Index............................................171 

Export ............................................................................... 152 

F 
Filter 

Archive/Un-Archive .................................................... 155 
Reports ........................................................................ 129 
Toolbar Command........................................................ 60 

Find command .................................................................. 67 
Form view ...................................................61, 64, 65, 67, 70 
Form View.......................................................................... 60 
Freeze Columns ................................................................ 65 

G 
Gage ID 

Archiving by................................................................. 155 
Go To Command................................................................ 70 
Graphs Menu 

Options..................................................................... 19, 57 
Gridlines............................................................................. 65 

H 
Hide Current Column ....................................................... 65 

I 
Importing Data ................................................................ 153 
Insert Object .................................................................... 136 
Inspect Material .......................................................... 42, 93 
inspection characteristics ......................................... 31, 81 
inspection form ........................................................... 40, 91 
inspection procedure ................................................. 24, 75 
Installation .................................................................. 15, 53 

K 
Keyboard shortcuts ........................................................ 117 

L 
Last Rating .............................................................. 109, 114 
Last Received .................................................................... 80 
Late grace period............................................................ 137 
Link 

Company Logo - OLE.................................................. 136 
Logo .................................................................................. 136 
Logon................................................................................ 142 

M 
Main Records Menu 

Options..................................................................... 19, 57 



 Index 

 

188 

Maximize/Minimize Buttons ............................................65 
Menu Bar............................................................................64 
Menus 

Organization.............................................................19, 57 
multiple databases..........................................................166 

N 
Navigation buttons ......................................................63, 64 
Navigation Buttons............................................................64 
Network ............................................................................171 
Network Installation.......................................................171 
network server......................................... 16, 19, 54, 57, 171 
No Database Found window.......................................19, 57 
Null Value ....................................................................31, 81 

O 
Object, Insert....................................................................136 
OLE ....................................................................25, 32, 76, 81 
open corrective action notices .......................................127 
output of reports................................................................66 
Output To ..........................................................................130 

P 
part alarms ..................................................................32, 82 
part calendar alarm ....................................................33, 83 
Part cloning ..................................................................35, 85 
part counter alarm ......................................................32, 82 
Part Procedure Cross-Reference report......................126 
Part Procedure report ....................................................126 
PIN.........................................................................17, 55, 142 
Pop-Up Calendar ...............................................................61 
Print Preview Keyboard Shortcuts ..............................129 
Printing 

Print Setup...................................................................130 
Printing Datasheets ..........................................................65 

Q 
Quick Sort .....................................................................69, 71 

R 
Rating Code ..............................................................108, 109 
rating setup ..............................................................107, 111 
Rating/Survey Structure .................................................140 
Rating/Survey Wizard .............................................111, 140 
Ratings Definition ....................................................107, 111 
Ratings report ..................................................................122 
received material records ..........................................37, 87 
Received Material report ................................................119 
Receiving History ..................................................39, 90, 91 
receiving inspection procedures ...................24, 31, 75, 81 
Receiving Log No.................................................38, 88, 170 
Record Selector Button ...................................................64 
Records 

Archive/Un-Archive.....................................................155 
Receiving Records ......................................................155 

Supplier Records........................................................ 156 
Reject No ..................................................................... 44, 95 
Reject tags ........................................................45, 46, 96, 97 
Rejected Material report........................................ 120, 122 
Rejected Material tags ............................................... 47, 97 
rejection notice ........................................................... 45, 96 
Rejection notice .......................................................... 45, 96 
rejection notices ............................................................. 121 
rejection records ........................................................ 43, 94 
Repairing Data Files ...................................................... 171 
Replace command ...................................................... 59, 68 
Report settings................................................................ 115 
Reports Menu 

Options..................................................................... 19, 57 
Restore..................................................................... 149, 150 
Restoring Data ................................................................ 150 
Row Height ........................................................................ 65 

S 
Sampling Plan ................................................................... 80 
Save Changes .................................................................... 65 
save records ...................................................................... 71 
Scroll bars ................................................................... 63, 65 
security ........................................................................ 17, 55 
Select All Records ............................................................ 67 
Select Record .................................................................... 67 
Send.....................................................................67, 117, 130 
serial number.............................................................. 17, 55 
Set Up Users.........................................................20, 58, 142 
Settings .........................................................20, 58, 130, 136 
Setup Menu 

Options..................................................................... 19, 57 
Show All Records.............................................................. 71 
Staff Entry.................................................................. 99, 103 
supplier alarms........................................................... 25, 76 
supplier counter alarm .............................................. 26, 77 
Supplier Detail report .................................................... 128 
Supplier Listing report ................................................... 124 
Supplier Master records ............................................ 21, 73 
Supplier Part Listing report .......................................... 125 
Supplier Part No ......................................................... 30, 80 
Supplier Part Performance report ............................... 118 
Supplier Part records................................................. 29, 79 
Supplier Performance report........................................ 118 
Supplier Procedure report ............................................ 126 
supplier procedures ....................................25, 76, 125, 126 
supplier rating records .................................................. 107 
supplier survey records ................................................. 111 
Survey report................................................................... 124 

T 
Table View.............................................................. 60, 65, 70 
Technical Support....................................165, 166, 170, 171 
Training 

Staff Records .............................................................. 104 



 SUPPLIERtrak™ User’s Manual 

 

189 

U 
undo changes .....................................................................71 
Unfreeze Columns.............................................................66 
User Rights ......................................................................143 
Utilities and Data Tools Menu 

Options .....................................................................19, 57 

W 
wildcard characters ..........................................................59 

Work Orders Menu 
Options..................................................................... 19, 57 

Z 
Zip ..................................................................................... 150 
Zip file................................................................149, 150, 151 
Zoom................................................................................... 61 

 




